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View detailed traceability paths and diagnostics for requirements-
based testing artifacts
In R2021a, you can view the traceability path from an artifact to its component in the Model Testing
Dashboard. On the Artifacts pane, right-click the artifact and click View trace to component. A
traceability graph opens in a new tab. The graph shows the connections and intermediate artifacts
that the dashboard traced from the component to the artifact. To see the relationship between two
artifacts, point to the arrow that connects the artifacts.

Additionally, when the dashboard traces your artifacts and collects metric results, you can view errors
and warnings in the new diagnostic viewer. At the bottom of the Model Testing Dashboard, click
Diagnostics. The diagnostic viewer shows warnings and errors that indicate:

• Artifacts that returned errors when loaded
• Artifacts that the dashboard does not support
• Links that the dashboard does not trace
• Model callbacks that the dashboard deactivates
• Test results without coverage
• Test results that do not include simulation results

Generate model testing metrics report
In R2021a, you can generate a PDF or HTML report of the metric results from the Model Testing
Dashboard. For each software component in the project, the report shows the metric results that
appear in the dashboard. Use the report to archive and share metric data on the quality and
completeness of your requirements-based testing activities.

To generate a report, use the new generateReport function. For an example of how to collect
metrics programmatically and generate a report, see “Collect Metrics on Model Testing Artifacts
Programmatically”.

Find artifacts in the Model Testing Dashboard by using navigation
enhancements
In R2021a, in the Model Testing Dashboard Artifacts pane, you can quickly find artifacts that you
want to investigate by expanding, collapsing, and scrolling to nodes in the artifact list. The menu to

the right of the search bar  enables you to:

• Collapse the expanded nodes in the list
• Collapse and expand the sections under the selected node
• Scroll to the component that the open dashboard tab reflects
• Scroll to the currently selected node

Additionally, you can right-click an artifact in the list to:

• Open the dashboard for the component that the artifact traces to
• Scroll to the component that the artifact traces to

R2021a
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• Scroll to the parent node that contains the artifact
• Show a file artifact in your file browser

Previously, you could view dashboard results for only one component at a time. In R2021a, you can
open the dashboard for each component in a separate tab in the Model Testing Dashboard dialog. On
the Artifacts pane, right-click a component and click Open in new tab.

Select software component models for analysis in the Model Testing
Dashboard
Previously, the Model Testing Dashboard showed traceability and analysis results for all models in
your project. In R2021a, you can specify the models that you want the dashboard to analyze by
labeling the models in the project. To label the software component models and configure the
dashboard to recognize them, see “Model Software Components for Requirements-Based Testing”. In
the Model Testing Dashboard, the Artifacts pane lists only the models that have the category and
label combination that you specified. By limiting the list to only software component models, you can
track your testing progress without sorting through models that do not use requirements-based
testing that the dashboard analyzes.

Additionally, in R2021a, the Model Testing Dashboard now analyzes these artifacts:

• Requirement links to embedded MATLAB functions
• Custom requirements
• Requirements links that have custom types
• Data dictionaries
• Test results that you have collected in the Test Manager but not exported to a results file

For more information about artifacts and links that the dashboard does not support, see “Resolve
Missing Artifacts, Links, and Results in the Model Testing Dashboard”.

Model Advisor checks for verifying compliance with High-Integrity
System Modeling guidelines
This table lists the new Model Advisor checks that verify compliance with the High-Integrity System
Modeling guidelines.

Model Advisor Check Check ID
“Check for divide-by-zero calculations” mathworks.hism.hisl_0067
“Check safety-related settings for hardware
implementation”

mathworks.hism.hisl_0071

“Check usage of recursions” mathworks.hism.hisf_0004
Check for model elements that do not link to
requirements

mathworks.hism.hisl_0070

Compatibility Considerations
In R2021a, due to compatibility considerations, the following checks have been removed from Model
Advisor:
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Model Advisor Check Check ID
Check safety-related optimization settings for
Loop unrolling threshold

mathworks.hism.hisl_0051

Create user-defined fields and review additional information when
designing block constraint checks
Following enhancements are made to block constraint check authoring:

• You can create user-defined fields to identify what check failures are caused by.
• Additional information is provided on what causes a check failure in the diagnostic window.
• Diagnostic window now lists information for multiple constraint violations.
• Diagnostic window includes links to the violating block parameters.
• You can click on violating block parameters to highlight them in the Block dialog box.

Add, remove, clear, get, save, and load exclusions programmatically in
the Model Advisor Exclusion Editor
The Model Advisor Exclusion Editor can now be used with the following functions:

Task Function Syntax
Add a new exclusion in Model
Advisor.

Advisor.addExclusion Advisor.addExclusion('modelna
me', 'type', 'id')

Remove exclusions from Model
Advisor.

Advisor.removeExclusion Advisor.removeExclusion('model
name', 'type', 'id')

Clear all exclusions from Model
Advisor.

Advisor.clearExclusion Advisor.clearExclusion('modelna
me')

Get exclusions for a model or a
filter.

Advisor.getExclusion Advisor.getExclusion('modelnam
e')

Save exclusions to the default
option or to a new file.

Advisor.saveExclusion Advisor.saveExclusion('modelna
me')

Load default exclusions stored
inside the model or according to
the path settings.

Advisor.loadExclusion Advisor.loadExclusion('modelna
me', 'filepath')

For more information, see “Exclude Blocks From the Model Advisor Check Analysis”.

Additional checks for JMAAB and MAB Guidelines
This table identifies the new Model Advisor checks that verify compliance with the MAB and JMAAB
Modeling guidelines.

Model Advisor Check Check ID MAB/JMAAB
“Check usage of graphical
functions in Stateflow”

mathworks.jmaab.jc_0804 MAB and JMAAB

R2021a
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Model Advisor Check Check ID MAB/JMAAB
“Check for division by zero in
Simulink”

mathworks.jmaab.jc_0794 MAB and JMAAB

“Check lines of code in MATLAB
Functions”

mathworks.jmaab.na_0016 MAB

“Check nested conditions in
MATLAB Functions”

mathworks.jmaab.na_0018 MAB

For more information, see “Model Checks for MAB and JMAAB Compliance”.

Use Model Advisor Exclusion Editor with Stateflow
From R2021a, the following enhancements to Model Advisor Exclusion Editor are added for
Stateflow®:

• Model Advisor exclusions can be applied to Stateflow states, transitions, junctions, MATLAB®

functions, graphical functions, Simulink® functions, Simulink based states, and truth tables.
• You can launch Model Advisor Exclusion Editor from the Stateflow context menu.
• You can launch Model Advisor Check Selector from the Stateflow context menu.
• You can launch Model Advisor from the Stateflow context menu.

For more information, see “Exclude Blocks From the Model Advisor Check Analysis”.

Enhancements to edit-time checking to identify additional
incompatibility issues
You can now identify compatibility issues earlier in the model design process by using edit-time
checking for Simulink Code Inspector™ checks. In R2021a, when you use edit-time checking, you can
view some violations of these Model Advisor checks:

• “Check for unsupported blocks” (Simulink Code Inspector)
• “Check model for reusable subsystems that use the same function interfaces” (Simulink Code

Inspector)
• “Check usage of Sources blocks” (Simulink Code Inspector)
• “Check usage of Signal Routing blocks” (Simulink Code Inspector)
• “Check usage of Math Operations blocks” (Simulink Code Inspector)
• “Check usage of Signal Attributes blocks” (Simulink Code Inspector)
• “Check usage of Logical and Bit Operations blocks” (Simulink Code Inspector)
• “Check usage of Lookup Tables blocks” (Simulink Code Inspector)
• “Check usage of Ports and Subsystems blocks” (Simulink Code Inspector)
• “Check usage of Discontinuities blocks” (Simulink Code Inspector)
• “Check usage of Sinks blocks” (Simulink Code Inspector)
• “Check usage of Discrete blocks” (Simulink Code Inspector)
• “Check usage of Stateflow charts” (Simulink Code Inspector)
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Edit-time checking does not flag violations for all the constraints of these checks. It flags some
specific constraint violations. For more information, see the check documentation and “Check Model
Compatibility While You Edit” (Simulink Code Inspector).

Inspect enhanced MCDC objectives generated by Simulink Design
Verifier using Model Slicer
You can now launch Model Slicer for satisfied enhanced MCDC objectives to verify that the test case
generated by Simulink Design Verifier™ impacts the detection site without being masked.

For more information, see “Enhanced MCDC Coverage in Simulink Design Verifier” (Simulink Design
Verifier).

Debug test failures using Model Slicer
You can now use Model Slicer in the Simulink Test Manager to debug failed verify signals. When you
simulate the model in debug mode, Model Slicer highlights the model components that impact the
failed signals at each time step. You can move between failure regions to debug the cause of the
verification failures.

Detect and replace clones in a model with command-line APIs
In R2021a, you can programmatically identify clones in a Simulink model and replace the clones with
links to library blocks.

Syntax Purpose
Simulink.CloneDetection.findClones Find clones in a model. Optionally, you can

constrain the threshold for matching a subsystem
by using Settings class.

Simulink.CloneDetection.replaceClones Replace the clones in a model with links to library
blocks. Optionally, you can replace clones with
reference blocks by using the
ReplacementConfig class.

Simulink.CloneDetection.checkEquivalen
cy

Check the equivalency of the original model with
the model created after clone replacement.

For more information, see Detect and Replace Clones Programmatically.

Improved clone detection for refactoring models with nested clones
and masked subsystem
In R2021a, you can now use clone detection to refactor models that contain clone groups under
another clone group. This feature also supports the refactoring and replacement of clones in masked
subsystems.

For more information, see Clone Detector and “Enable Component Reuse by Using Clone Detection”.

R2021a
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Edit-time checking support for library blocks
In R2021a, edit-time checks identify modeling issues for library blocks in a model. For more
information on edit-time checking, see “Check Model Compliance by Using the Model Advisor”.

Improved analysis of models that have callbacks in the Model Testing
Dashboard
Previously, when the Model Testing Dashboard analyzed a model, any loading and closing model
callbacks were executed. Model callbacks that changed the model resulted in an error or stale results
in the Model Testing Dashboard. In R2021a, when the dashboard analyzes a model, loading and
closing callbacks are not executed.
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Model Testing Dashboard: Track completeness of requirements-based
testing for compliance to standards such as ISO 26262
Assess the status and quality of your requirements-based testing by using metric data in the new
Model Testing Dashboard. The metrics in the dashboard measure different aspects of model testing
completeness and quality based on industry-recognized standards such as ISO 26262 and DO-178.
Use the dashboard to view:

• Summary data for requirements, tests, and traceability between requirements and tests
• Status and results of the latest test runs
• Model coverage measurements achieved by tests and justifications
• A list of the artifacts in the project, organized by the associated models

The dashboard widgets show a summary of the testing metric data for one component. To explore the
data in more detail, click an individual widget. A table lists the artifacts in the component and their
results for the metric. The table provides hyperlinks to open each artifact so that you can view details
about the artifact and address testing quality issues. For more information about using the Model
Testing Dashboard, see Explore Status and Quality of Testing Activities Using the Model Testing
Dashboard.

In R2020b, you can also collect the metrics programmatically by using the new metric API. To collect
metrics for a project, use these new objects and functions.

Object Description
metric.Engine Collect testing metric data for a project
metric.Result Access results for a testing metric

Function Description
execute Collect testing metric data for a metric engine
getMetrics Return testing metric results from a metric

engine
openArtifact Open the artifact that a metric result references
getArtifactErrors View errors that occurred during artifact analysis

Viewing the metric results data and details in the dashboard requires a Simulink Check™ license. To
collect results for a metric, you must have the licenses required to edit the associated artifacts, such
as Simulink Requirements™, Simulink Test™, or Simulink Coverage™. For more information on the
metrics and the required licenses, see Model Testing Metrics.

Faster calculation of Model Advisor metric checks
In R2020b, the Model Advisor collects and analyzes data for Model Metrics checks faster than in
R2020a.

Previously, the Subsystem depth metric check returned results for both the Subsystem Depth and
Subsystem Level for a component. In R2020b, the metric is simplified to return only the Subsystem
Depth result. The result is the depth of a component relative to the top level of the hierarchy, which
is the analysis root. For more information, see Subsystem depth metric.

R2020b
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Additionally, the Cyclomatic complexity metric check no longer shows aggregated results for a
component and its descendants. Instead, the metric shows only local results for the component. For
more information, see Cyclomatic complexity metric.

Compatibility Considerations
Previously, the Subsystem depth metric check returned these results for the components in a
hierarchy:

• Value — The maximum depth of all hierarchical children of a component. In the Model Advisor,
this result was labelled Subsystem Depth.

• Measure — The depth of a component relative to the top level of the hierarchy (the analysis root).
In the Model Advisor, this result was labelled Subsystem Level.

In R2020b, the metric no longer returns the maximum depth of hierarchical children of a component,
which was previously returned in the Value. Instead, the Value result is the depth of a component
relative to the top level of the hierarchy. This data was previously returned as the Measure result.
The metric no longer returns a measure result.

Debug counter examples from Design Error Detection results in
Simulink Design Verifier using Model Slicer
You can now use Model Slicer along with Simulink Design Verifier to debug the Design Error
Detection violations. Following are the design errors supported:

• Division by zero
• Integer Overflow
• Non-Finate and NaN (Not a Number) floating-point values
• Specified minimum and maximum value violations
• Datastore access violations
• Specified block input range violations

For more information, see Debug Integer Overflow Design Error Detection using Model Slicer
(Simulink Design Verifier).

Updates to JMAAB Checks
This table lists the JMAAB checks that can now be run by selecting the Guideline Sub-IDs.

Model Advisor Check Check ID
Check usable characters for signal names and
bus names

mathworks.jmaab.jc_0222

Check usable characters for parameter names mathworks.jmaab.jc_0232
Check usage of Lookup Tables mathworks.jmaab.jc_0626
Check usage of Discrete-Time Integrator block mathworks.jmaab.jc_0627
Check usable characters for Stateflow data
names

mathworks.jmaab.jc_0795
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Model Advisor Check Check ID
Check for unconnected signal lines and blocks mathworks.jmaab.db_0081
Check transitions in Stateflow Flow charts mathworks.jmaab.db_0132
Check for propagated signal labels mathworks.jmaab.jc_0009

The following table lists the JMAAB checks that are now edit-time compliant.

Model Advisor Check Check ID
Check usage of parallel states mathworks.jmaab.jc_0721
Check usage of transitions to external states mathworks.jmaab.jc_0723
Check starting point of internal transition in
Stateflow

mathworks.jmaab.jc_0760

Check prohibited combination of state action and
flow chart

mathworks.jmaab.jc_0762

Check Stateflow chart action language mathworks.jmaabjc_0790
Check for state in state machines mathworks.jmaab.db_0137
Check for MATLAB expressions in Stateflow
charts

mathworks.jmaab.db_0127

Check transitions in Stateflow Flow charts mathworks.jmaab.db_0132
Check entry formatting in State blocks in
Stateflow charts

mathworks.jmaab.jc_0501

For more information, see Model Checks for MAB and JMAAB Compliance.

Test failure debugging using Model Slicer
You can now use the Model Slicer in the Test Manager to debug a failed signal in a baseline test
failure. When you simulate the model in debug mode, the model components that impact the failed
signal are highlighted for each time step. You can move between failure regions to debug the cause of
the baseline differences. To use this feature, you must have a Simulink Check license.

For more information, see Debugging Baseline Test Failures Using Model Slicer (Simulink Test).

Improvements to Model Advisor Exclusion Editor
Model Advisor Exclusion Editor is now revamped to be a customizable editor with the following
improvements:

• Trace model object from the exclusion editor.
• Edit exclusions from the exclusion editor view.
• Select multiple checks together to perform group actions through Check Selector window.
• Display details of the checks in resizeable columns.
• Display Check titles and Check groups.
• Check Selector with grouping mechanism (tree hierarchy).
• Sorting mechanism for Exclusion Editor columns.
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• Improvements to Save and Search mechanism.
• Search option in Check Selector window.

For more information, see Exclude Blocks From the Model Advisor Check Analysis.

Model Advisor checks for verifying compliance with High-Integrity
System Modeling guidelines
This table identifies the new Model Advisor checks that verify compliance with High-Integrity System
Modeling guidelines. Running these checks triggers an extensive analysis using Simulink Design
Verifier.

Model Advisor Check Check ID
Check usage of Sqrt blocks mathworks.hism.hisl_0003
Check usage of Reciprocal Sqrt blocks mathworks.hism.hisl_0028
Check usage of Math Function blocks (rem and
reciprocal functions)

mathworks.sldv.hism.hisl_0002

Check usage of Math Function blocks (log and
log10 functions)

mathworks.sldv.hism.hisl_0004

In R2020b, due to compatibility considerations, the following checks are removed from Model
Advisor:

Model Advisor Check Check ID
Check usage of Math Function blocks (rem and
reciprocal functions)

mathworks.hism.hisl_0002

Check usage of Math Function blocks (log and
log10 functions)

mathworks.hism.hisl_0004

Model Advisor checks for ISO 25119 and EN 50657 standards
A new check group was added to the Model Advisor. You can use these checks to verify compliance
with ISO 25119 standards. To execute these check, open the Model Advisor and click on:

• By Product > Simulink Check > Modeling Standards > IEC 61508, IEC 62304, ISO 26262,
ISO 25119, EN 50128, and EN 50657 Checks

• By Task > Modeling Standards for ISO 25119

You can use the EN 50128 checks to verify compliance with EN 50657:2017 standards. To reflect this
change, these Model Advisor folders have been updated:

• By Product > Simulink Check > Modeling Standards > IEC 61508, IEC 62304, ISO 26262,
ISO 25119, EN 50128, and EN 50657 Checks

• By Task > Modeling Standards for ISO 50128/EN 50657

For more information about the checks, see IEC 61508, IEC 62304, ISO 26262, ISO 25119, and EN
50128/EN 50657 Checks.
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Refactor models by replacing exact clones with Subsystem Reference
blocks
In R2020a, you could refactor a model by replacing similar and exact clones with library links. In
R2020b, in addition to library links, you can replace exact clones with Subsystem Reference blocks.

To enable model refactoring, open a model and select Configure Match Settings > Replace Exact
Clones with Subsystem Referencesunder the Settings drop-down menu.

For more information, see Replace Exact Clones with Subsystem Reference.
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Model Advisor checks to support MAB v5.0 modeling guidelines
In R2020a, the MathWorks® Automotive Advisory Board (MAAB) modeling guidelines is reintroduced
as the MathWorks Advisory Board (MAB) modeling guidelines, version 5.0.

The Model Advisor is updated to support the new modeling guidelines. To view the MAB checks, use
either:

• By Product > Simulink Check > Modeling Standards > MAB Checks
• By Task > Modeling Standards for MAB

This table identifies the new Model Advisor checks for the MAB v5.0 modeling guidelines.

Model Advisor Check Check ID
Check length of model file name mathworks.jmaab.jc_0241
Check length of folder name at every level of
model path

mathworks.jmaab.jc_0242

Check length of subsystem names mathworks.jmaab.jc_0243
Check length of block names mathworks.jmaab.jc_0247
Check length of Inport and Outport names mathworks.jmaab.jc_0244
Check usable characters for signal names and
bus names

mathworks.jmaab.jc_0222

Check usable characters for parameter names mathworks.jmaab.jc_0232
Check length of signal and bus names mathworks.jmaab.jc_0245
Check length of parameter names mathworks.jmaab.jc_0246
Check usable characters for Stateflow data
names

mathworks.jmaab.jc_0795

Check length of Stateflow data name mathworks.jmaab.jc_0796
Check duplication of Simulink data names mathworks.jmaab.jc_0791
Check unused data in Simulink Model mathworks.jmaab.jc_0792
Check for unused data in Stateflow Charts mathworks.jmaab.jc_0700
Check Signed Integer Division Rounding mode mathworks.jmaab.jc_0642
Check diagnostic settings for incorrect
calculation results

mathworks.jmaab.jc_0806

Check Model Description mathworks.jmaab.jc_0603
Check if blocks are shaded in the model mathworks.jmaab.jc_0604
Check block orientation mathworks.jmaab.jc_0110
Check for consistency in model element names mathworks.jmaab.jc_0602
Check for avoiding algebraic loops between
subsystems

mathworks.jmaab.jc_0653

Check signal line labels mathworks.jmaab.jc_0008
Check for propagated signal labels mathworks.jmaab.jc_0009
Check signal flow in model mathworks.jmaab.db_0097
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Model Advisor Check Check ID
Check if tunable block parameters are defined as
named constants

mathworks.jmaab.jc_0645

Check for sample time setting mathworks.jmaab.jc_0641
Check usage of fixed-point data type with non-
zero bias

mathworks.jmaab.jc_0643

Check type setting by data objects mathworks.jmaab.jc_0644
Check undefined initial output for conditional
subsystems

mathworks.jmaab.jc_0640

Check usage of Merge block mathworks.jmaab.jc_0659
Check default/else case in Switch Case blocks
and If blocks

mathworks.jmaab.jc_0656

Check operator order of Product blocks mathworks.jmaab.jc_0610
Check signs of input signals in product blocks mathworks.jmaab.jc_0611
Check for parentheses in Fcn block expressions mathworks.jmaab.jc_0622
Check icon shape of Logical Operator blocks mathworks.jmaab.jc_0621
Comparing floating point types in Simulink mathworks.jmaab.jc_0800
Check usage of Lookup Tables mathworks.jmaab.jc_0626
Check usage of Memory and Unit Delay blocks mathworks.jmaab.jc_0623
Check for cascaded Unit Delay blocks mathworks.jmaab.jc_0624
Check usage of Discrete-Time Integrator block mathworks.jmaab.jc_0627
Check usage of the Saturation blocks mathworks.jmaab.jc_0628
Check output data type of operation blocks mathworks.jmaab.jc_0651
Check display for port blocks mathworks.maab.jc_0081
Check for usage of Data Store Memory blocks mathworks.jmaab.jc_0161
Check input and output datatype for Switch
blocks

mathworks.jmaab.jc_0650

Check settings for data ports in Multiport Switch
blocks

mathworks.jmaab.jc_0630

Check definition of Stateflow events mathworks.jmaab.db_0126
Check usable number for first index mathworks.jmaab.jc_0701
Check execution timing for default transition path mathworks.jmaab.jc_0712
Check scope of data in parallel states mathworks.jmaab.jc_0722
Check for unconnected objects in Stateflow
Charts

mathworks.jmaab.jc_0797

Check usage of exclusive and default states in
state machines

mathworks.maab.db_0137

Check for parallel Stateflow state used for
grouping

mathworks.jmaab.jc_0721

Check usage of transitions to external states mathworks.jmaab.jc_0723
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https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw.jc_0659
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#jc_0656
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#jc_0656
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#jc_0610
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw.jc_0611
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#jc_0622
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#jc_0621
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https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_8fb00adb-c0bf-490f-8cb5-22fb2fa5d9d6
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_9c1d1a14-52a9-473e-8849-efc7e64d599f
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw.jc_0628
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_4fa60ed4-f7ea-4e68-89a4-702458e44bb6
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#briw0u0-1
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_85497171-e2d5-4d18-9e9d-82dbd061c13a
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_54f98412-aa4a-4650-806a-e34402d684aa
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_54f98412-aa4a-4650-806a-e34402d684aa
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_d60c90ef-1b61-495c-b153-961a1aa60b1b.jc_0630
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_d60c90ef-1b61-495c-b153-961a1aa60b1b.jc_0630
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_c16b1933-2f5f-4fb1-8670-dad5c70787d0
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#jc_0701
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw.jc_0712
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_d60c90ef-1b61-495c-b153-961a1aa60b1b.jc_0722
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#jc_0797
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#jc_0797
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#briw0sm-1
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#briw0sm-1
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_d60c90ef-1b61-495c-b153-961a1aa60b1b.jc_0721
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_d60c90ef-1b61-495c-b153-961a1aa60b1b.jc_0721
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_822e8edf-4466-464f-b448-3be0ae4d0018


Model Advisor Check Check ID
Check for unexpected backtracking in state
transitions

mathworks.jmaab.jc_0751

Check starting point of internal transition in
Stateflow

mathworks.jmaab.jc_0760

Check usage of internal transitions in Stateflow
states

mathworks.jmaab.jc_0763

Check prohibited combination of state action and
flow chart

mathworks.jmaab.jc_0762

Check transition orientations in flow charts mathworks.maab.db_0132
Check usage of unconditional transitions in flow
charts

mathworks.jmaab.jc_0773

Check terminal junctions in Stateflow mathworks.jmaab.jc_0775
Check usage of Stateflow comments mathworks.jmaab.jc_0738
Check Stateflow chart action language mathworks.jmaab.jc_0790
Check usage of numeric literals in Stateflow mathworks.jmaab.jc_0702
Check order of state action types mathworks.jmaab.jc_0733
Check repetition of Action types mathworks.jmaab.jc_0734
Check if state action type 'exit' is used in the
model

mathworks.jmaab.jc_0740

Check updates to variables used in state
transition conditions

mathworks.jmaab.jc_0741

Check usage of transition conditions in Stateflow
transitions

mathworks.jmaab.jc_0772

Check condition actions and transition actions in
Stateflow

mathworks.jmaab.jc_0753

Check prohibited comparison operation of logical
type signals

mathworks.jmaab.jc_0655

Check for implicit type casting in Stateflow mathworks.jmaab.jc_0802
Check uniqueness of Stateflow State and Data
names

mathworks.jmaab.jc_0732

Check uniqueness of State names mathworks.jmaab.jc_0730
Check usage of State names mathworks.jmaab.jc_0731
Check indentation of code in Stateflow states mathworks.jmaab.jc_0736
Check for usage of text inside states mathworks.jmaab.jc_0739
Check placement of Label String in Transitions mathworks.jmaab.jc_0770
Check position of comments in transition labels mathworks.jmaab.jc_0771
Check usage of parentheses in Stateflow
transitions

mathworks.jmaab.jc_0752

Check for comments in unconditional transitions mathworks.jmaab.jc_0774
Check usage of Simulink function in Stateflow mathworks.jmaab.na_0042
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https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw.jc_0751
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw.jc_0751
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https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw.jc_0762
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#bruujm0-1
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_70e611ef-3136-47eb-9452-f3741fc7e04b
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_70e611ef-3136-47eb-9452-f3741fc7e04b
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_002f3eee-ca69-4b01-b112-4314d7cde1ec
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw.jc_0738
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#jc_0790
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_4d608893-5e5e-4016-8fdb-6e8ef424e774
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https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw.jc_0734
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_fdbb7c13-5232-4646-ba62-beaaef22630d
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_fdbb7c13-5232-4646-ba62-beaaef22630d
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw.jc_0741
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw.jc_0741
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_d60c90ef-1b61-495c-b153-961a1aa60b1b.jc_0772
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_d60c90ef-1b61-495c-b153-961a1aa60b1b.jc_0772
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw.jc_0753
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw.jc_0753
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw.jc_0655
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw.jc_0655
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_a59a7d9a-cf44-4dcf-aef1-750140c786bd
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_d60c90ef-1b61-495c-b153-961a1aa60b1b.jc_0732
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_d60c90ef-1b61-495c-b153-961a1aa60b1b.jc_0732
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw.jc_0730
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw.jc_0731
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw.jc_0736
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_d60c90ef-1b61-495c-b153-961a1aa60b1b.jc_0739
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#jc_0770
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_2e0dff1a-87f8-43dd-ad9d-78365141ee51
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw.jc_0752
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw.jc_0752
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https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_ee6d8382-3a43-41df-a3e1-20b13d01dbfc


Compatibility Considerations
In some instances, checks already existed but their IDs and/or titles have changed. This table maps
the previous check ID to their new check ID. When a check name has changed, the "Model Advisor
Check Name" column specifies the check name for both R2019b and R2020a.

Model Advisor Check Name R2019b Check ID R2020a Check ID
Check file names mathworks.maab.ar_0001 mathworks.jmaab.ar_0001
Check folder names mathworks.maab.ar_0002 mathworks.jmaab.ar_0002
Check Subsystem names mathworks.maab.jc_0201 mathworks.jmaab.jc_0201
Check port block names mathworks.maab.jc_0231 mathworks.jmaab.jc_0211
Check Model font settings

(R2019b) Check font formatting

mathworks.maab.db_0043 mathworks.jmaab.db_0043

Check signal line connections

(R2019b) Check Simulink signal
appearance

mathworks.maab.db_0032 mathworks.jmaab.db_0032

Check connections between
structural subsystems

(R2019b) Check usage of Goto
and From blocks between
Subsystems

mathworks.maab.jc_0171 mathworks.jmaab.jc_0171

Check trigger signal names

(R2019b) Check Trigger and
Enable block names

mathworks.maab.jc_0281 mathworks.jmaab.jc_0281

Check usage of vector and bus
signals

(R2019b) Check usage of buses
and Mux blocks

mathworks.maab.na_0010 mathworks.jmaab.na_0010

Check position of conditional
blocks and iterator blocks

(R2019b) Check position of
Trigger and Enable blocks

mathworks.maab.db_0146 mathworks.jmaab.db_0146

Check fundamental logical and
numerical operations

mathworks.maab.na_0002 mathworks.jmaab.na_0002

Check usage of Sum blocks mathworks.maab.jc_0121 mathworks.jmaab.jc_0121
Check position of Inport and
Outport blocks

mathworks.maab.db_0042 mathworks.jmaab.db_0042
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Model Advisor Check Name R2019b Check ID R2020a Check ID
Check for missing ports in
Variant Subsystems

(R2019b) Check unused ports in
Variant Subsystems

mathworks.maab.na_0020 mathworks.jmaab.na_0020

Check for Strong Data Typing
with Simulink I/O

mathworks.maab.db_0122 mathworks.jmaab.db_0122

Check definition of Stateflow
data

(R2019b) Check Stateflow data
objects with local scope

mathworks.maab.db_0125 mathworks.jmaab.db_0125

Check for Stateflow transition
appearance

mathworks.maab.db_0129 mathworks.jmaab.db_0129

Check default transition
placement in Stateflow charts

mathworks.maab.jc_0531 mathworks.jmaab.jc_0531

Check for use of C-style
comment symbols

mathworks.maab.jc_0801 mathworks.jmaab.jc_0801

Check for usage of events and
broadcasting events in
Stateflow charts

(R2019b) Check for event
broadcasts in Stateflow charts

mathworks.maab.jm_0012 mathworks.jmaab.jm_0012

Check for MATLAB expressions
in Stateflow charts

mathworks.maab.db_0127 mathworks.jmaab.db_0127

Check Stateflow operators

(R2019b) Check for bitwise
operations in Stateflow charts

mathworks.maab.na_0001 mathworks.jmaab.na_0001

This table identifies the Model Advisor checks that are no longer available in the Model Advisor
because the corresponding modeling guideline is removed in R2020a. You will receive a warning
when you run these checks under the following circumstances:

• When you load/save a configuration that includes these checks: Model Advisor checks for
MAAB and JMAAB are updated to support the MAB modeling guidelines. For more
information, see the R2020a Release Notes.

• When you run the checks by using ModelAdvisor.run() on the MATLAB command line:

In R2020a, MAAB modeling guidelines were updated and renamed to the MAB
modeling guidelines. As a result, the guideline for check “<check name”
(ID: <check ID>) was removed and the check is no longer needed to verify
compliance.

For more information about modeling guidelines that are were removed from the MAB 5.0 guidelines,
see Support for MathWorks Advisory Board (MAB) 5.0 modeling guidelines

R2020a

3-6

https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_7b133788-3d20-4d10-b32a-4e5b5c319799
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_7b133788-3d20-4d10-b32a-4e5b5c319799
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#briw0r2-1
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#briw0r2-1
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_8859f927-769f-407f-ab2e-b1c0221b83e2
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_8859f927-769f-407f-ab2e-b1c0221b83e2
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#db_0129
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#db_0129
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#jmaab_jc_0531
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#jmaab_jc_0531
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_b9022458-fa39-4dae-b6fb-9d8a0a33531d
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Model Advisor Check Check ID
Check orientation of Subsystem blocks mathworks.maab.jc_0111
Check character usage in signal labels mathworks.maab.jc_0221
Check reuse of variables within a Stateflow scope mathworks.maab.jc_0491
Check usage of return values from Stateflow
graphical functions

mathworks.maab.jc_0521

Check for prohibited blocks in discrete
controllers

mathworks.maab.jm_0001

Check for matching port and signal names mathworks.maab.jm_0010
Check visibility of block port names mathworks.maab.na_0005
Check for comparison operations in Stateflow
charts

mathworks.maab.na_0013

Check usage of non-compliant blocks mathworks.maab.na_0027
Check Simulink bus signal names mathworks.maab.na_0030
Check usage of merge blocks mathworks.maab.na_0032
Check transition actions in Stateflow charts mathworks.maab.db_0151
Check nested states in Stateflow charts mathworks.maab.na_0038
Check number of Stateflow states per container mathworks.maab.na_0040

Automate checking of models to comply with JMAAB 5.1 modeling
guidelines
The following table identifies the new and updated checks to the JMAAB group for verifying
compliance with JMAAB 5.1.

To execute these checks, open Model Advisor and select By Task > Modeling Standards for
JMAAB.

Model Advisor Check Check ID
Check signal line connections mathworks.jmaab.db_0032
Check position of Inport and Outport blocks mathworks.jmaab.db_0042
Check Model font settings mathworks.jmaab.db_0043
Check Indexing Mode mathworks.jmaab.db_0112
Check definition of Stateflow data mathworks.jmaab.db_0125
Check definition of Stateflow events mathworks.jmaab.db_0126
Check for MATLAB expressions in Stateflow
charts

mathworks.jmaab.db_0127

Check for Stateflow transition appearance mathworks.jmaab.db_0129
Check usage of exclusive and default states in
state machines

mathworks.maab.db_0137

Check position of conditional blocks and iterator
blocks

mathworks.jmaab.db_0146

 

3-7

https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#db_0032
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#briw0m0-1
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#bruue27-1
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_51d8cd93-7a9a-45dd-b4f5-d1b80a686e6f
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_8859f927-769f-407f-ab2e-b1c0221b83e2
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_c16b1933-2f5f-4fb1-8670-dad5c70787d0
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#db_0127
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#db_0127
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#db_0129
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#briw0sm-1
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#briw0sm-1
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#briw0pk-1
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#briw0pk-1


Model Advisor Check Check ID
Check usage of Sum blocks mathworks.jmaab.jc_0121
Check for usage of Data Store Memory blocks mathworks.jmaab.jc_0161
Check connections between structural
subsystems

mathworks.jmaab.jc_0171

Check entry formatting in State blocks in
Stateflow charts

mathworks.maab.jc_0501

Check for cascaded Unit Delay blocks mathworks.jmaab.jc_0624
Check condition actions and transition actions in
Stateflow

mathworks.jmaab.jc_0753

Check duplication of Simulink data names mathworks.jmaab.jc_0791
Check for usage of events and broadcasting
events in Stateflow charts

mathworks.jmaab.jm_0012

Check Stateflow operators mathworks.jmaab.na_0001
Check fundamental logical and numerical
operations

mathworks.jmaab.na_0002

Check usage of vector and bus signals mathworks.jmaab.na_0010
Check logical expressions in If blocks mathworks.maab.na_0003
Check scope of From and Goto blocks mathworks.maab.na_0011
Check for missing ports in Variant Subsystems mathworks.jmaab.na_0020
Check usage of character vector inside MATLAB
Function block

mathworks.maab.na_0021

Check usage of enumerated values mathworks.maab.na_0031
Check use of default variants mathworks.maab.na_0036
Check use of single variable variant conditionals mathworks.maab.na_0037
Check use of Simulink in Stateflow charts mathworks.maab.na_0039
Check usage of Simulink function in Stateflow mathworks.jmaab.na_0042
Check Subsystem names mathworks.jmaab.jc_0201

Model Advisor checks for verifying compliance with DO-254 safety
standards
In R2020a, Model Advisor introduces checks that verify compliance with DO-254 safety standards. To
check compliance with the DO-254 standards, open the Model Advisor and run the checks in By Task
> Modeling Standards for DO-254. For more information, see Model Checks for DO-254 Standard
Compliance.

The following table lists the DO-254 checks:

DO-254 Checks
Display model version information
Identify disabled library links

R2020a
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https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_7b133788-3d20-4d10-b32a-4e5b5c319799
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_bb52c7d8-a6e3-4ac2-8a2b-e490de980ef9
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_bb52c7d8-a6e3-4ac2-8a2b-e490de980ef9
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#na_0031
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_b0ba3b1f-94c2-40fc-9d4c-a58694ad972d
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_bd29fead-d44e-43e4-bf4b-546142b5a69c
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/mab-jmaab-model-advisor-checks.html#mw_e7d54a5d-c878-4760-8600-a30b7f1c6fa6
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https://www.mathworks.com/help/releases/R2020a/slcheck/ref/do-178c-checks.html#brc3q67-1
https://www.mathworks.com/help/releases/R2020a/simulink/slref/simulink-checks_bq6d4aa-1.html#bragj2g-1


DO-254 Checks
Identify parameterized library links
Identify unresolved library links
Check for model reference configuration mismatch
Identify requirement links that specify invalid locations within documents
Identify requirement links with missing documents
Identify requirement links with path type inconsistent with preferences
Identify selection-based links having descriptions that do not match their requirements document
text

The following table lists the High Integrity System Model checks that are supported by DO-254 safety
standards:

High Integrity System Model Checks
Check for inconsistent vector indexing methods
Check for variant blocks with 'Generate preprocessor conditionals' active
Check for root Inports with missing properties
Check for Relational Operator blocks that equate floating-point types
Check usage of Relational Operator blocks
Check usage of Logical Operator blocks
Check sample time-dependent blocks
Check safety-related block reduction optimization settings
Check usage of Abs blocks
Check usage of Assignment blocks
Check for root Inports with missing range definitions
Check for root Outports with missing range definitions
Check Stateflow charts for transition paths that cross parallel state boundaries
Check Stateflow charts for ordering of states and transitions
Check Stateflow debugging options
Check Stateflow charts for uniquely defined data objects
Check usage of shift operations for Stateflow data
Check Stateflow charts for unary operators
Check for Strong Data Typing with Simulink I/O
Check MATLAB Code Analyzer messages
Check safety-related model referencing settings
Check safety-related diagnostic settings for parameters
Check safety-related diagnostic settings for type conversions
Check safety-related diagnostic settings for signal connectivity
Check safety-related diagnostic settings for bus connectivity
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https://www.mathworks.com/help/releases/R2020a/slrequirements/ug/requirements-consistency-checks.html#briw0e_-1
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https://www.mathworks.com/help/releases/R2020a/slrequirements/ug/requirements-consistency-checks.html#briw0f0-1
https://www.mathworks.com/help/releases/R2020a/slrequirements/ug/requirements-consistency-checks.html#briw0f0-1
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#hisl_0021
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#hisl_0023
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#hisl_0024
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#hisl_0017
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#hisl_0016
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#hisl_0018
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#hisl_0007
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#hisl_0046
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#hisl_0001
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#hisl_0029
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#hisl_0025
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#hisl_0026
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#hisf_0013
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#hisf_0002
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#hisf_0011
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#hisl_0061
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#hisf_0064
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#hisf_0211
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#hisf_0009
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#himl_0004
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#hisl_0037
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#hisl_0302
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#hisl_0309
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#hisl_0306
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#hisl_0307


High Integrity System Model Checks
Check safety-related diagnostic settings for model initialization
Check safety-related diagnostic settings for model referencing
Check safety-related diagnostic settings for saving
Check safety-related diagnostic settings for Stateflow
Check model object names
Check for model elements that do not link to requirements
Check for inappropriate use of transition paths
Check usage of Bitwise Operator block
Check data types for blocks with index signals
Check model file name
Check if/elseif/else patterns in MATLAB Function blocks
Check switch statements in MATLAB Function blocks
Check global variables in graphical functions
Check for length of user-defined object names
Check usage of conditionally executed subsystems
Check usage of standardized MATLAB function headers
Check usage of relational operators in MATLAB Function blocks
Check usage of equality operators in MATLAB Function blocks
Check usage of logical operators and functions in MATLAB Function blocks
Check naming of ports in Stateflow charts
Check scoping of Stateflow data objects
Check usage of Gain blocks
Check usage of bitwise operations in Stateflow charts
Check data type of loop control variables

The following table lists the HDL Coder checks that are supported by DO-254 safety standards:

HDL Code Advisor Checks
Check for infinite and continuous sample time sources (HDL Coder)
Check for unsupported blocks (HDL Coder)
Check for large matrix operations (HDL Coder)
Identify unconnected lines, input ports, and output ports (Simulink)
Identify disabled library links (Simulink)
Identify unresolved library links (Simulink)
Check for MATLAB Function block settings (HDL Coder)
Check for Stateflow chart settings (HDL Coder)
Check Delay, Unit Delay and Zero-Order Hold blocks for rate transition (Simulink)
Check for unsupported storage class for signal objects (HDL Coder)
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HDL Code Advisor Checks
Check VHDL file extension (HDL Coder)
Check naming conventions (HDL Coder)
Check top-level subsystem/port names (HDL Coder)
Check module/entity names (HDL Coder)
Check signal and port names (HDL Coder)
Check package file names (HDL Coder)
Check generics (HDL Coder)
Check clock, reset, and enable signals (HDL Coder)
Check architecture name (HDL Coder)
Check entity and architecture (HDL Coder)
Check clock settings (HDL Coder)
Check model for foreign characters (Simulink)
Check for global reset setting for Xilinx and Altera devices (HDL Coder)
Check inline configurations setting (HDL Coder)
Check algebraic loops (HDL Coder)
Check for visualization settings (HDL Coder)
Check delay balancing setting (HDL Coder)
Check for safe model parameters (HDL Coder)
Check for double datatypes in the model with Native Floating Point (HDL Coder)
Check for Data Type Conversion blocks with incompatible settings (HDL Coder)
Check for HDL Reciprocal block usage (HDL Coder)
Check for Relational Operator block usage (HDL Coder)
Check for unsupported blocks with Native Floating Point (HDL Coder)
Check for blocks with nonzero output latency (HDL Coder)
Check blocks with nonzero ulp error (HDL Coder)
Check for single datatypes in the model (HDL Coder)
Check initial conditions of enabled and triggered subsystems (HDL Coder)
Check for invalid top level subsystem (HDL Coder)

Model Advisor checks for verifying compliance with High-Integrity
System Modeling guidelines
This table identifies the new and updated Model Advisor checks that verify compliance with High-
Integrity System Modeling guidelines.
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Model Advisor Check Check ID Description of Change
Check safety-related diagnostic
settings for model referencing

mathworks.hism.hisl_0310 In R2020a, configuration
parameter Model block
version mismatch is removed
from the check.

The parameter has been
removed from corresponding
guideline hisl_0310:
Configuration Parameters >
Diagnostics > Model
Referencing (Simulink).

Customize your Model Advisor by using the redesigned configuration
editor
In R2020a, the Model Advisor Configuration Editor user interface is redesigned to provide a more
flexible and streamline way for you to create custom Model Advisor configurations and modify
existing Model Advisor configurations.

To open the Model Advisor Configuration Editor from the Simulink toolstrip:

• In the Model Advisor gallery of the Modeling tab, select Model Advisor Configuration Editor.
• In the Modeling tab, select Model Advisor. From the Model Advisor dialog, select Settings >

Open Configuration Editor.

For more information about creating a custom configuration, see Use the Model Advisor
Configuration Editor to Customize the Model Advisor

Format of the Model Advisor Configuration File

Previously, Model Advisor configuration files were saved as .mat files. Starting in
R2020a,configuration files are saved as .json files.

Warning Message for Missing Checks When Loading Configuration

Previously, you were automatically warned of checks that were missing in the Model Advisor when
loading the Model Advisor configuration. In R2020a, you can suppress this message by highlighting
the top-level folder in the check hierarchy and selecting the Suppress warning messages for
missing checks when loading configuration button in the Model Advisor Configuration Editor.

To programmatically suppress the warning for Model Advisor configurations, in the MATLAB
command line, enter
warning('off','Simulink:tools:MALoadConfigMissCorrespondCheck').

For more information, see Suppress Warning Message for Missing Checks.

Specify Results Severity for Failed Checks

You can now specify whether you want the check to be marked as a warning or failure when the
check flags an issue in your model. In the Model Advisor Configuration Editor, from the Check result
when issues are flagged list, select Warning or Fail. For more information, see Customize the
Model Advisor Configuration.

R2020a

3-12

https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#hisl_0310
https://www.mathworks.com/help/releases/R2020a/slcheck/ref/hism-checks_hism_checks.html#hisl_0310
https://www.mathworks.com/help/releases/R2020a/simulink/mdl_gd/hi/diagnostics.html#bs5xnrt-1
https://www.mathworks.com/help/releases/R2020a/simulink/mdl_gd/hi/diagnostics.html#bs5xnrt-1
https://www.mathworks.com/help/releases/R2020a/simulink/mdl_gd/hi/diagnostics.html#bs5xnrt-1
https://www.mathworks.com/help/releases/R2020a/simulink/mdl_gd/hi/diagnostics.html#bs5xnrt-1
https://www.mathworks.com/help/releases/R2020a/slcheck/ug/organizing-checks-and-folders-using-the-model-advisor-configuration-editor.html
https://www.mathworks.com/help/releases/R2020a/slcheck/ug/organizing-checks-and-folders-using-the-model-advisor-configuration-editor.html
https://www.mathworks.com/help/releases/R2020a/slcheck/ug/organizing-checks-and-folders-using-the-model-advisor-configuration-editor.html#mw_0e0e9bd9-fde2-4c67-88b3-4bb8090a01f7
https://www.mathworks.com/help/releases/R2020a/slcheck/ug/organizing-checks-and-folders-using-the-model-advisor-configuration-editor.html#mw_ddabbaf1-b4dd-40fc-8019-d1a683e1bdd8
https://www.mathworks.com/help/releases/R2020a/slcheck/ug/organizing-checks-and-folders-using-the-model-advisor-configuration-editor.html#mw_ddabbaf1-b4dd-40fc-8019-d1a683e1bdd8


For custom Model Advisor checks, you can specify the result severity for the check by using the new
ModelAdvisor.Check.ErrorSeverity property.

Programmatically Set the Default Configuration

You can use function ModelAdvisor.setDefaultConfiguration to programmatically set the
default configuration that is used by the Model Advisor. Using these methods is equivalent to
selecting Set as Default in the Model Advisor Configuration Editor. For more information, see
Specify a Default Configuration File.

Removal of the AggregateComponentDetails property
In R2020a, the slmetric.metric.Metric class Boolean property
AggregateComponentDetails has been removed.

Compatibility Considerations
For custom metrics, the removal of this property means that you can no longer specify whether to
aggregate noncomponent values to the parent component. Remove the
AggregateComponentDetails property from your metric algorithm functions. Noncomponents are
Simulink objects that are not:

• Models
• Subsystem blocks
• Charts
• MATLAB Function blocks
• Protected models
• Library blocks

Because of this change, the cyclomatic complexity metric no longer includes chart states in its
calculation. For more information, see Cyclomatic complexity metric.

Enhanced calculation of cyclomatic complexity
In R2019b, the cyclomatic complexity metric calculation counted each element of a vectorized
operation as a separate decision point. As a result, for a simple model with a signal that is a vector or
matrix, the Metrics Dashboard might have reported a cyclomatic complexity much higher than 30—
the threshold value between the compliant and warning range. In R2020a, the cyclomatic complexity
metric calculation considers a vectorized operation as a single decision point, thereby lowering the
cyclomatic complexity value for some models.

For example, consider the following simple model, which has a vector signal of size 50. This signal
branches to two signals. Two blocks perform calculations on each signal.
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In R2019b, this model had a cyclomatic complexity of 101. In R2020a, this model has a cyclomatic
complexity of 3. This is a more reasonable value for a simple model. For more information, see
Cyclomatic complexity metric.

Compatibility Considerations
Previously, models with vectorized operations had higher cyclomatic complexity values than they have
in R2020a.

Removal of restore point from the Model Advisor
Prior to 2020a, you could use the Model Advisor to save a restore point, which is a snapshot in time of
your model, base workspace, and Model Advisor. You could then load the restore point to revert
changes that you made to your model in response to the check results.

In R2020a, the ability to save and load a restore point by using these Model Advisor menu options has
been removed:

• File > Save Restore Point As
• File > Save Restore Point
• File > Load Restore Point

Removal of the Model Advisor Results Advisor View
Some Model Advisor checks have an Explore Results button that opens the Model Advisor Result
Explorer. The Model Advisor Results Explorer allows you to quickly locate, view, and change elements
of a model. In R2020a, Explore Results has been removed from the checks.

Compatibility Considerations
You can use the hyperlinks in the Model Advisor results to view and modify model elements that are
being flagged by the Model Advisor check. For more information, see Address Model Check Results
(Simulink). You can also apply batch changes to model parameters from the command line using the
set_param command.
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For custom checks, set the ModelAdvisor.Check.CallbackStyle property to 'DetailStyle'.

New Customizing Model Advisor Example
In R2020a, Simulink Check contains a new model and example that demonstrate how to author
custom Model Advisor checks and deploy a custom Model Advisor configuration. The name of the new
model is AdvisorExampleCustomization.slx. This model replaces the previous
slvnvdemo_mdladv model. To access the example, model and supporting files, see Create and
Deploy a Model Advisor Custom Configuration.
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Refactor models using clone detection
In R2019b, to detect clones in your model, use the new Clone Detector app. This app is available in
the Apps tab in the Simulink Toolstrip. The Clone Detector helps you to refactor your model and
replace the clones with library links.

The Clone Detector interface steps you through the process of identifying and refactoring clones. You
can:

• Access clone reuse percentages in the model to determine the benefits of refactoring.
• Vary parameter tolerance to identify similar and exact clones.
• Identify the differences in a clone from the baseline subsystem.
• Access a log of clone detection results.
• Use a Simulink Test license to access an embedded Test Manager that allows you to verify the

equivalence of the refactored model and the original model.

For more information, see Clone Detector and Enable Component Reuse by Using Clone Detection.

Model Advisor checks for verifying compliance with High-Integrity
System Modeling guidelines
This table identifies the new and updated Model Advisor checks that verify compliance with High-
Integrity System Modeling guidelines.

Model Advisor Check Check ID Description of Change
Check type and size of
conditional expressions

mathworks.hism.himl_0011 New check that verifies the use
of logical scalars for data type
and size in condition
expressions.

Check safety-related code
generation identifier settings

mathworks.hism.hisl_0049 In R2019b, the configuration
parameters pane Code
Generation > Symbols is
renamed as Code Generation
> Identifiers. The Model
Advisor check was updated to
reflect this change.

Check blocks not supported for code generation by using edit-time
checks
In R2019b, when you open the C Code app (available with Embedded Coder® or Simulink Coder™),
you can specify whether you want to view modeling issues for code generation on the canvas while
editing by selecting the C/C++ Code Advisor > Edit-Time Checks box.

For a GRT-based targets, edit-time checking identifies blocks not supported for code generation.

For ERT-based targets, edit-time checking identifies:

• Blocks not supported for code generation

R2019b
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• Blocks not recommended for code generation

Note In R2019a, violations of the ERT-based edit-time check were flagged automatically without the
edit-time checks functionality being enabled. In R2019b, you must enable edit-time checks to view
these violations on the canvas.

For more information, see:

• Check Your Model by Using Edit Time Checks
• Blocks and Products Supported for Code Generation (Embedded Coder)
• Configure a System Target File (Embedded Coder)
• Embedded Coder app

JMAAB 5.1 Support: Automate checking of models to comply with
JMAAB 5.1 modeling style guidelines
The following table identifies the new and updated checks to the JMAAB group for verifying
compliance with JMAAB 5.1. For more information, see Model Checks for Japan MATLAB Automotive
Advisory Board (JMAAB) Guideline Compliance.

To execute these checks, open Model Advisor and select By Task > Modeling Standards for
JMAAB.

Model Advisor Check Check ID
Check file names mathworks.jmaab.ar_0001
Check folder names mathworks.jmaab.ar_0002
Check subsystem names mathworks.jmaab.jc_0201
Check port block names mathworks.jmaab.jc_0211
Check character usage in block names mathworks.jmaab.jc_0231
Check trigger signal names mathworks.jmaab.jc_0281
Check for consistency in model element names mathworks.jmaab.jc_0602
Check Model Description mathworks.jmaab.jc_0603
Check operator order of Product blocks mathworks.jmaab.jc_0610
Check for sample time setting mathworks.jmaab.jc_0641
Check output data type of operation blocks mathworks.jmaab.jc_0651
Check usable number for first index mathworks.jmaab.jc_0701
Check usage of numeric literals in Stateflow mathworks.jmaab.jc_0702
Check usage of transitions to external states mathworks.jmaab.jc_0723
Check order of state action types mathworks.jmaab.jc_0733
Check indentation of code in Stateflow states mathworks.jmaab.jc_0736
Check usage of Stateflow comments mathworks.jmaab.jc_0738
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Model Advisor Check Check ID
Check if state action type 'exit' is used in the
model

mathworks.jmaab.jc_0740

Check usage of internal transitions in Stateflow
states

mathworks.jmaab.jc_0763

Check placement of Label String in Transitions mathworks.jmaab.jc_0770
Check position of comments in transition labels mathworks.jmaab.jc_0771
Check usage of unconditional transitions in flow
charts

mathworks.jmaab.jc_0773

Check for comments in unconditional transitions mathworks.jmaab.jc_0774
Check terminal junctions in Stateflow mathworks.jmaab.jc_0775
Check unused data in Simulink Model mathworks.jmaab.jc_0792
Check for use of C-style comment symbols mathworks.jmaab.jc_0801
Check for implicit type casting in Stateflow mathworks.jmaab.jc_0802
Check diagnostic settings for incorrect
calculation results

mathworks.jmaab.jc_0806

Access Simulink Check capabilities from Simulink Toolstrip
In R2019b, these Simulink Check capabilities are in the Apps tab, in the Verification, Validation,
and Test section:

• Model Slicer
• Metrics Dashboard
• Clone Detector
• Model Transformer

The Modeling tab contains a Model Advisor gallery where you can access the Model Advisor
Configuration Editor.

Collect metric data for referenced models running in accelerated
mode
Previously, you could collect metric data for only referenced models running in normal simulation
mode. On the Metrics Dashboard, you collected this data by selecting Options > Include Model
References.

In R2019b, you can collect metric data for referenced models running in accelerated mode. To collect
these metrics, open the Metrics Dashboard and select the new Options > Include referenced
models (all modes) button. This setting is on by default. There are two new buttons for collecting
metrics for referenced models running only in normal simulation mode or to exclude referenced
models from the analysis.

In R2019b, you can programmatically collect metric data for referenced models running in
accelerated mode. For an slmetric.Engine object, you collect this data by setting the new
ModelReferencesSimulationMode property to AllModes. This new property has these settings.

R2019b
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Setting Description
None Metric engine does not collect metric data for referenced

models.
NormalModeOnly Metric engine collects metric data only for referenced models

running in normal simulation mode.
AllModes Metric engine collects metric data for referenced models

running in normal and accelerated simulation modes.

Compatibility Considerations
Previously, to collect metric data for referenced models, you set the AnalyzeModelReferences
property to 1 (default). In R2019b, you get a warning stating that this property will be removed in a
future release. To avoid getting this warning, use the new ModelReferencesSimulationMode
property.

For more information, see Collect Model Metric Data by Using the Metrics Dashboard and
slmetric.Engine.

Enhancement to Model Advisor compliance metrics
In R2019a, the Model Advisor Check Issues for High-Integrity Systems metric
(mathworks.metrics.ModelAdvisorCheckIssues.hisl_do178) and the Model Advisor Check
Issues for MAAB Standards metric (mathworks.metrics.ModelAdvisorCheckIssues.maab) did
not count model advisor checks that contained warnings or failures if these checks did not contain a
link to a block or signal in the model. In R2019b, these metrics count each Model Advisor check that
produces a warning or failure. If a check contains links to blocks, this metric counts one issue for
each linked block. Checks with links to the model are highlighted in the Simulink Editor. For more
information, see Model Metrics and Collect and Explore Metric Data by Using the Metrics Dashboard.
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Model Slicer available with Simulink Check
Previously, the Model Slicer was available with Simulink Design Verifier. In R2019a, the tool is
available with Simulink Check. Use the Model Slicer to determine the interdependencies of blocks,
signals, and model components throughout a model. Also, use Model Slicer to create simplified
standalone models that are easier to understand and analyze yet retain their original context. To
access the Model Slicer, select Analysis > Model Slicer. For more information, see Model
Simplification with Dependency Analysis.

Hierarchical view of metrics dashboard results
In R2019a, you can view metric data for related components together by viewing Metric Dashboard
results in a model hierarchical view. You can then better understand aggregated model metric data.
To use the model hierarchical view, run the Metrics Dashboard on your model. Click a widget and
then click the new Tree button. The figure shows metric results for the model sf_car in the Tree
view.

For more information on the Metrics Dashboard, see Collect and Explore Metric Data by Using the
Metrics Dashboard.

Filters for metrics dashboard results
In R2019a, you can filter Metrics Dashboard results by component type, name, and path. After you
run the Metrics Dashboard, to drill into a widget's metric details, select that widget. In the Table
view, select the context menu on the right side of the TYPE, COMPONENT, and PATH column
headers. From the TYPE menu, select applicable components. From the COMPONENT and PATH
menus, type a component name or path in the search bar. The Metrics Dashboard saves the filters for
a widget, so you can view metric details for other widgets and return the filtered results. You cannot
specify filters on the High Integrity and MAAB compliance widgets.

Filters enable you to quickly locate results. For example, to locate results for only Stateflow Charts,
you can select that component from the TYPE menu. To analyze results for one Stateflow Chart, type
its name or path in the COMPONENT or PATH search bar. For more information, see Collect Model
Metric Data by Using the Metrics Dashboard.
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Streamline compliance with modeling guidelines by using enhanced
edit-time check diagnostics
Edit-Time check diagnostics interface

Enhancements to the edit-time checking capability make it easier for you to identify and resolve
compatibility issues earlier in the model design process.

In R2019a, when you click the warning icon that appears over the highlighted block, the Model
Advisor identifies compliance issues in the block that violate edit-time checks. When a block has
multiple check violations, you can move between the violations by using the << and >> buttons. The
cause of each issue is provided.

For information on checking your model while you edit, see Check Model Compliance by Using the
Model Advisor.

Model Advisor checks evaluated by using edit-time checking

In R2019a, when you use edit-time checking, you can view violations of these Model Advisor checks.
See the check documentation for additional information and limitations.

• Check usage of non-compliant blocks
• Check length of subsystem names
• Check length of Inport and Outport names
• Check length of block names
• Check operator order of Product blocks
• Check icon shape of Logical Operator blocks
• Check settings for data ports in Multiport Switch blocks
• Check usage of Switch blocks
• Check for unsupported block names
• Check for blocks not recommended for MISRA C:2012
• Check for switch case expressions without a default case
• Check usage of Assignment blocks
• Check for blocks not recommended for secure coding standards
• Identify lookup table blocks that generate expensive out-of-range checking code
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JMAAB 5.1 Support: Automate checking of models to comply with
JMAAB 5.1 modeling style guidelines
The JMAAB check group has been updated to support the latest release of the Japan MATLAB
Automotive Advisory Board (JMAAB) guidelines 5.1. New checks have been added to support new
guideline rules and removed when no longer applicable.

The following table identifies the new checks added to the JMAAB group for verifying compliance
JMAAB 5.1. For more information, see Model Checks for Japan MATLAB Automotive Advisory Board
(JMAAB) Guideline Compliance.

To execute these checks, open Model Advisor and select By Task > Modeling Standards for
JMAAB.

Model Advisor Check Check ID
Check default transition placement in Stateflow
charts (JMAAB)

mathworks.jmaab.jc_0531

Check duplication of Simulink data names mathworks.jmaab.jc_0791
Check for avoiding algebraic loops between
subsystems

mathworks.jmaab.jc_0653

Check for unconnected objects in Stateflow
Charts

mathworks.jmaab.jc_0797

Check for usage of text inside states mathworks.jmaab.jc_0739
Check length of Stateflow data names mathworks.jmaab.jc_0796
Check placement of Label String in Transitions mathworks.jmaab.jc_0770
Check settings for data ports in Multiport Switch
blocks

mathworks.jmaab.jc_0630

Check Stateflow chart action language mathworks.jmaab.jc_0790
Check usable characters for Stateflow data
names

mathworks.jmaab.jc_0795

Comparing floating point types in Simulink mathworks.jmaab.jc_0800
Check signal line labels (JMAAB) mathworks.jmaab.jc_0008
Check for propagated signal labels mathworks.jmaab.jc_0009

The following table identifies checks that are no longer applicable to JMAAB 5.1 and have been
removed from the JMAAB check group.

Check ID Model Advisor Check
mathworks.jmaab.jc_0735 Check if each action in state label ends with a semicolon
mathworks.jmaab.jc_0737 Check if operators (ActionLanguage) for States and/or

Transitions in Stateflow have uniform spaces around
them.

mathworks.jmaab.jc_0742 Guidelines for writing boolean operations in condition
labels in Stateflow transitions

R2019a

5-4

https://www.mathworks.com/help/releases/R2019a/slcheck/ug/model-checks-for-japan-mbd-automotive-advisory-board-jmaab-guideline-compliance.html
https://www.mathworks.com/help/releases/R2019a/slcheck/ug/model-checks-for-japan-mbd-automotive-advisory-board-jmaab-guideline-compliance.html
https://www.mathworks.com/help/releases/R2018a/slcheck/ug/model-checks-for-japan-mbd-automotive-advisory-board-jmaab-guideline-compliance.html


Check ID Model Advisor Check
mathworks.jmaab.jc_0743 Guidelines for writing condition actions in Stateflow

transitions
mathworks.jmaab.jc_0756 Prohibited use of operation expressions in array indices
mathworks.maab.db_0151 Check transition actions in Stateflow charts
mathworks.maab.hd_0001 Check for prohibited sink blocks
mathworks.maab.himl_0003 Check MATLAB Function metrics
mathworks.maab.jc_0111 Check orientation of Subsystem blocks
mathworks.maab.jc_0221 Check character usage in signal labels
mathworks.maab.jm_0001 Check for prohibited blocks in discrete controllers
mathworks.maab.na_0008 Check signal line labels
mathworks.maab.na_0009 Check for propagated signal labels
mathworks.maab.na_0013 Check for comparison operations in Stateflow charts
mathworks.maab.jc_0281 Check Trigger and Enable block names

Additional MAAB 3.0 Checks: Improve quality and compliance to
guidelines 
This table identifies the new checks for verifying compliance with MATLAB Automotive Advisory
Board Checks 3.0 (MAAB) guidelines. For information about MAAB guidelines, see Model Advisor
Checks for MAAB Guidelines.

Model Advisor Check Check ID
Check Simulink signal appearance mathworks.maab.db_0032
Check for Stateflow transition appearance mathworks.maab.db_0129
Check usage of Goto and From blocks
between Subsystems

mathworks.maab.jc_0171

Check reuse of Variables within a Stateflow
scope

mathworks.maab.jc_0491

Check usage of non-compliant blocks mathworks.maab.na_0027
Check usage of enumerated values mathworks.maab.na_0031

For more information, see Model Checks for MathWorks Automotive Advisory Board (MAAB)
Guideline Compliance.

Added functions for edit-time checking
In R2019a, there are two new edit-time checking functions. Use the new
edittime.setAdvisorChecking method to check for Model Advisor violations while you edit. The
edittime.setAdvisorChecking method is equivalent to selecting Analysis > Model Advisor >
Display Advisor Checks in Editor. Use the new edittime.getAdvisorChecking method to find
out if Edit-time checking is on or not. For more information on edit-time checking, see Check Model
Compliance by Using the Model Advisor.
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Model optimization by sharing prelookup operation of n-D lookup
tables
In R2019a, you can use the Model Transformer tool to improve the simulation speed for models with
n-D Lookup table blocks by reusing the Prelookup operation with multiple blocks. This transformation
results in decreased ROM usage and increased execution speed in the generated code.

You can run the Transform table lookup into prelookup and interpolation check on the Model
Transformer tool to convert models.

A limitation is that the model transformation is confined to a single subsystem and does not extend
beyond the subsystem boundaries. For further details, refer to Improve Efficiency of Simulation by
Optimizing Prelookup Operation of Lookup Table Blocks

Clone metrics include exact and similar clones
Previously, when you ran the Metrics Dashboard on a model, the tool reported only exact clones in
the Potential Reuse widget. Exact clones have identical block types, connections, and parameter
values. When you clicked Open Conversion Tool, the Clone Detection tool ran and reported only
exact clones because the Maximum number of different parameters parameter was set to 0
(default value). The Clone content and the Clone detection metrics included only exact clones as part
of their calculations.

In R2019a, the Metrics Dashboard reports exact and similar clones in the Potential Reuse widget.
Similar clones have identical block types and connections, but they can have different block
parameter values. When you click Open Conversion Tool, the Clone Detection tool also reports
exact and similar clones because the Maximum number of different parameters parameter is set
to a high value. The Clone content and the Clone detection metrics include exact and similar clones
as part of their calculations. For more information on the Metrics Dashboard, see Collect Model
Metric Data by Using the Metrics Dashboard.

Model slicer support for multi-instance model reference 
You can now use model slicer on a Simulink model that contains multiple references to the same
model in normal simulation mode.

Model Advisor option to compile model for code generation
In R2019a, the value 'PostCompileForCodegen' is added to the
ModelAdvisor.Check.CallbackContext property. Use this option when developing custom
Model Advisor checks to ensure code generation readiness of the model.

When using the existing 'PostCompile' option, the Model Advisor updates the model diagram and
simulates the model. These Model Advisor checks do not flag modeling issues that fail during code
generation because these issues do not affect the simulated model.

With the 'PostCompileForCodegen' option, the Model Advisor updates the model diagram
specifically for code generation and does not assume that the model is being simulated. As a result,
custom Model Advisor checks can identify code generation setup issues in a model at an earlier stage,
avoiding unexpected errors during code generation.
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The 'PostCompileForCodegen' option compiles for all variant choices in a model. This enables
you to analyze possible issues present in the generated code for both active and inactive variant
paths in the model. To compile for all variant choices, on the Variant system block, select the
Analyze all choices during update diagram and generate preprocessor
conditionals parameter.

Using the 'PostCompileForCodegen' option can increase the amount of time to execute your
Model Advisor checks.

For additional information, see:

• ModelAdvisor.Check.CallbackContext
• Define the Compile Option for Custom Checks
• Variant Systems (Simulink)

Updates for verifying compliance with High-Integrity Systems
Modeling guidelines
This table identifies the updates to the checks that verify compliance with High-Integrity Systems
Modeling guidelines.

Model Advisor Check Check ID Description of Change
Check usage of relational
operators in MATLAB Function
blocks

mathworks.hism.himl_00
08

Flags the MATLAB relational operators
that are used in functional format. For
example:

• lt - Less than
• ne - not equal to

Check usage of equality
operators in MATLAB Function
blocks

mathworks.hism.himl_00
09

Check usage of Bitwise Operator
block

mathworks.hism.hisl_001
9

Checks the Bitwise Operations for
Signed data types.

Check usage of bitwise
operations in Stateflow charts

mathworks.hism.hisf_000
3

Check Stateflow debugging
options

mathworks.hism.hisf_001
1

Checks the parameter Underspecified
and Overspecified in the Settings
menu of the Truth Table Editor, to
Error.
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Model Advisor Check Check ID Description of Change
Check usage of conditionally
executed subsystems

mathworks.hism.hisl_001
2

Extends support on the following
sample-time dependent blocks:

• Discrete Filter
• Discrete Fir
• Discrete State Space
• Discrete Transfer Fcn
• Discrete Zero Pole
• Discrete Integrator
• First Order Transfer Fcn
• Lead or Lag Compensator
• Transfer Fcn Real Zero
• Discrete Derivative
• Discrete Transfer Function with

Initial Outputs
• Discrete Transfer Function with

Initial States
• Discrete Zero-Pole with Initial

Outputs
• Discrete Zero-Pole with Initial States

Check usage of Merge blocks mathworks.hism.hisl_001
5

Checks the Outport block parameter
Output when disabled to held for
each conditionally executed subsystem
being merged.
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Model Advisor Check Check ID Description of Change
Check for inconsistent vector
indexing methods

mathworks.hism.hisl_002
1

Extends support on the following:

Blocks that support configurable
indexing:

• Index Vector
• Multiport Switch
• Assignment
• Selector
• For Iterator

Blocks that support only one-based
indexing:

• Fcn
• MATLAB Function
• MATLAB System
• State Transition Table
• Test Sequence
• Truth Table block
• Stateflow chart with MATLAB action

language
• Truth Table function with MATLAB

action language

Blocks that supports only zero-based
indexing:

• Stateflow chart with C action
language

• Truth Table function with C action
language

Check usage of shift operations
for Stateflow data

mathworks.hism.hisf_006
4

Does not check the negative values.

For more information, see Model Checks for High Integrity Systems Modeling Checks.

MISRA C:2012 and Secure Coding checks to improve compliance of
generated code
Modifications to existing Model Advisor checks that you use to verify compliance with MISRA C:2012
and Secure Coding standards are outlined in this table.
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Model Advisor Check Description of Change
Check configuration parameters for MISRA
C:2012

Check configuration parameters for secure
coding standards

Checks now analyze the setting for these configuration
parameters:

• Include comments (GenerateComments)
• MATLAB user comments (MATLABFcnDesc)

Check for missing error ports for AUTOSAR
receiver interfaces

When an error port is missing, the check flags receiver
interface ports with these AUTOSAR data access mode
types:

• ImplicitReceive
• ExplicitReceive
• EndToEndRead

Tech Preview of model refactoring using clone detection
In R2019a, you can use the Clone Detector app that has a new and improved user interface. This user
interface facilitates:

• Display of clones detected hierarchically as model view, tree view, list view, and clones plot.
• Displays the report from the clone refactorization and enables you to restore the model to its

original state.

The Clone Detector app is a technical preview in R2019a. To try it out, turn on the Simulink Toolstrip.
For more information, see “Simulink Toolstrip Tech Preview replaces menus and toolbars in the
Simulink Desktop”.

The documentation does not reflect the addition of the Clone Detection app. There is documentation
for the existing Clone Detection tool. For more information, see Enable Component Reuse by Using
Clone Detection.

The new user interface contains 5 distinct sections representing the workflow as shown below :

To access the parameter settings for help, results, and model properties of the Clone Detector app,
click the Perspective menu.

You can use the settings present on the PREPARE tab to set the conditions for clone detection.

To identify clones in the model, click the Find Clones icon. The percentage of overall, exact, and
similar clones that can replaced by library blocks is displayed.

To refactor the models by creating links to library blocks of similar clones, click the Replace clones
button. Backup models are created in case you want to restore models to their original
configurations.
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To open the Test Manager, that tests the equivalence between the original and modified model,click
the Check Equivalency button.
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Metrics Dashboard Customization: Configure compliance metrics, add
metric thresholds, and customize Metrics Dashboard layout
Configure Compliance Metrics

In R2018b, you can use the Metrics Dashboard and metric APIs to obtain compliance and issues data
on your Model Advisor configuration. To set up your Model Advisor configuration, see Organize
Checks and Folders Using the Model Advisor Configuration Editor. After you have set up your
configuration, create an slmetric.config.Configuration object. Use the
setMetricFamilyParameterValues method to specify the check group for which you want to
obtain compliance and issues data.

This code sample is for one check group.
CONF = slmetric.config.Configuration.new('Name', 'config.xml');
CONF.setMetricFamilyParameterValues('ModelAdvisorStandard',...
  {'SysRoot_$optimization_checks'})
CONF.save('FileName','config.xml')
slmetric.config.setActiveConfiguration(fullfile(pwd, 'config.xml')); 

SysRoot_$optimization_checks is the Check Group ID. In the Model Advisor Configuration
Editor, this ID is on your custom folder. ModelAdvisorStandard is a standard string that you must
specify as an input to the setMetricFamilyParameterValues method. To visualize results, use the
new “Customize Metrics Dashboard Layout” on page 6-3 feature to add custom widgets to the
Metrics Dashboard. You can also run the metric engine using APIs to obtain results.

Add Metric Thresholds

In R2018a, you could run the Metrics Dashboard to collect metric data on your model and use the
various widgets to explore this data in more detail. Starting in R2018b, you can apply thresholds for
categorizing metric data and display these thresholds on the Metrics Dashboard. Setting these
thresholds enables you to assess the quality of your model. You use new APIs to specify threshold
values corresponding to these three categories:

• Compliant — Metric data that is in an acceptable range.
• Warning — Metric data that requires review.
• Noncompliant — Metric data that requires you to modify your model.

After you specify thresholds and update the active configuration, you can run the Metrics Dashboard.
To specify metric thresholds, use these five new classes and two new functions:

Class Description
slmetric.config.Configuration Specify metric data categories and custom metric

families
slmetric.config.ThresholdConfigura
tion

Object for holding a collection of metric data
thresholds

slmetric.config.Threshold Specify metric and slmetric.metric.Result
property for thresholding

slmetric.config.Classification Specify categorical metric data ranges
slmetric.metric.ResultClassificati
on

Access metric data threshold values
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Function Description
slmetric.config.getActiveConfigura
tion

Obtain file path and name of XML file containing
active Metrics Dashboard custom configuration

slmetric.config.setActiveConfigura
tion

Activate custom configuration for metric engine to use

The slmetric.metric.Result class contains two new properties: Category and
Classifications. The slmetric.metric.ResultCollection class contains the new property
Category.

Customize Metrics Dashboard Layout

In R2018b, you can customize the layout and functionality of the Metrics Dashboard. For custom
metrics, you can visualize metric results by adding widgets to the Metrics Dashboard. You can choose
among these visualization techniques:

• Radial gauge
• Single value
• Bar chart
• Distribution heatmap

You can also configure where existing, shipped widgets appear on the Metrics Dashboard or remove
these widgets.

To add custom metrics and configure existing metrics to display on the Metrics Dashboard, use these
six new classes and two new functions :

Class Description
slmetric.dashboard.Configura
tion

Specify custom Metrics Dashboard configuration.

slmetric.dashboard.Layout Add or remove widgets from the Metrics Dashboard.
slmetric.dashboard.Container Add widgets next to each other on the Metrics Dashboard.
slmetric.dashboard.Group Add a title to a group of widgets and place them next to each

other on the Metrics Dashboard.
slmetric.dashboard.Widget Object that holds a Library Reuse, System Interface, or

System Info widget. Library Reuse and System Interface
widgets are for existing, shipped metrics, so you cannot
change the visualization property or metric ID. You cannot
assign a metric ID to a System Info widget because it is not a
metric.

slmetric.dashboard.CustomWid
get

Create widgets in which you specify a visualization property
and metric ID.
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Class Description
slmetric.metric.MetaInformat
ion

The slmetric.metric.MetaInformation class properties
contain metric metadata. On the Metrics Dashboard, when
you click the widget for an individual metric, this metadata is
in the table. For custom metrics, when you create a custom
metric class, you specify the
slmetric.metric.MetaInformation properties. To obtain
metric metadata, use the new getMetricMetaInformation
method. This method is for the slmetric.Engine object.

Function Description
slmetric.dashboard.getActive
Configuration

Return slmetric.dashboard.Configuration object
corresponding to active Metrics Dashboard configuration.

slmetric.dashboard.setActive
Configuration

Set active Metrics Dashboard configuration.

To create widgets for custom metrics, use the slmetric.dashboard.CustomWidget class. Add
these widgets and shipped widgets in groups and containers or by themselves on the Metrics
Dashboard.

For an example of all three of the preceding features, see Customize Metrics Dashboard Layout and
Functionality.

Simscape Support with Clone Detection: Detect and refactor clones in
Simscape Models
In R2018b, you can run the Identify Modeling Clones tool on Simscape models.

JMAAB 4.01 Support: Automate checking of models to comply with
JMAAB 4.01 modeling style guidelines
Use these new checks to verify compliance with Japan MATLAB Automotive Advisory Board Checks
(JMAAB) guidelines. To execute these checks, open Model Advisor and select By Task > Modeling
Standards for JMAAB.

Model Advisor Check Check ID
Check block orientation mathworks.jmaab.jc_0110
Check usable characters for signal names and
bus names

mathworks.jmaab.jc_0222

Check usable characters for parameter names mathworks.jmaab.jc_0232
Check length of model file name mathworks.jmaab.jc_0241
Check length of folder name at every level of
model path

mathworks.jmaab.jc_0242

Check length of subsystem names mathworks.jmaab.jc_0243
Check length of Inport and Outport names mathworks.jmaab.jc_0244
Check length of signal and bus names mathworks.jmaab.jc_0245
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Model Advisor Check Check ID
Check length of parameter names mathworks.jmaab.jc_0246
Check length of block names mathworks.jmaab.jc_0247
Check if blocks are shaded in the model mathworks.jmaab.jc_0604
Check operator order of Product blocks mathworks.jmaab.jc_0610
Check icon shape of Logical Operator blocks mathworks.jmaab.jc_0621
Check for parentheses in Fcn block expressions mathworks.jmaab.jc_0622
Check usage of Memory and Unit Delay blocks mathworks.jmaab.jc_0623
Check usage of Lookup Tables mathworks.jmaab.jc_0626
Check usage of the Saturation blocks mathworks.jmaab.jc_0628
Check Signed Integer Division Rounding mode mathworks.jmaab.jc_0642
Check type setting by data objects mathworks.jmaab.jc_0644
Check if tunable block parameters are defined as
named constants

mathworks.jmaab.jc_0645

Check prohibited comparison operation of logical
type signals

mathworks.jmaab.jc_0655

Check default/else case in Switch Case blocks
and If blocks

mathworks.jmaab.jc_0656

Check usage of Merge block mathworks.jmaab.jc_0659
Check for unused data in Stateflow Charts mathworks.jmaab.jc_0700
Check first index of arrays in Stateflow mathworks.jmaab.jc_0701
Check execution timing for default transition path mathworks.jmaab.jc_0712
Check for parallel Stateflow state used for
grouping

mathworks.jmaab.jc_0721

Check scope of data in parallel states mathworks.jmaab.jc_0722
Check uniqueness of State names mathworks.jmaab.jc_0730
Check usage of State names mathworks.jmaab.jc_0731
Check uniqueness of Stateflow State and Data
names

mathworks.jmaab.jc_0732

Check repetition of Action types mathworks.jmaab.jc_0734
Check if each action in state label ends with a
semicolon

mathworks.jmaab.jc_0735

Check indentation of Stateflow blocks mathworks.jmaab.jc_0736
Check uniform spaces before and after operators mathworks.jmaab.jc_0737
Check comments in state actions mathworks.jmaab.jc_0738
Check updates to variables used in state
transition conditions

mathworks.jmaab.jc_0741

Check boolean operations in condition labels mathworks.jmaab.jc_0742
Check condition actions in Stateflow transitions mathworks.jmaab.jc_0743
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Model Advisor Check Check ID
Check for unexpected backtracking in state
transitions

mathworks.jmaab.jc_0751

Check usage of parentheses in Stateflow
transitions

mathworks.jmaab.jc_0752

Check condition actions and transition actions in
Stateflow

mathworks.jmaab.jc_0753

Check prohibited use of operation expressions in
array indices

mathworks.jmaab.jc_0756

Check starting point of internal transition in
Stateflow

mathworks.jmaab.jc_0760

Check prohibited combination of state action and
flow chart

mathworks.jmaab.jc_0762

Check usage of internal transitions in Stateflow
states

mathworks.jmaab.jc_0763

Check usage of transition conditions in Stateflow
transitions

mathworks.jmaab.jc_0772

For more information, see Model Checks for Japan MATLAB Automotive Advisory Board (JMAAB)
Guideline Compliance.

Additional MAAB 3.0 and High Integrity Checks: Improve quality and
compliance to guidelines 
The following table identifies the new and updated checks to verify compliance with MAAB 3.0
guidelines. For information about MAAB guidelines, see Model Advisor Checks for MAAB Guidelines.

Model Advisor Check Description of Change
Check for blocks not recommended for C/C+
+ production code deployment

Removed from the Model Advisor By Task >
Modeling Standards for MAABchecks. Check is not
applicable for verifying compliance with MAAB
modeling guidelines.

Check the number of function calls in
MATLAB Function blocks

Use this new check to verify compliance with
MathWorks® Automotive Advisory Board (MAAB)
guidelines. To execute these check, open Model
Advisor and select By Task > Modeling Standards
for MAAB.

In R2018b, existing DO-178C/DO-331, and EN 50128, IEC 61508, IEC 62304, and ISO 26262 check
IDs are renamed for better usability and consistency. For more information, see the information in
this table.

Model Advisor Check DO-178C/DO-331 IEC 61508, IEC 62304,
ISO 26262, EN 50128

Check ID in R2018b

Check for MATLAB
Function interfaces with
inherited properties

mathworks.do178.himl_
0002

mathworks.iec61508.hi
ml_0002

mathworks.hism.himl_0
002

R2018b
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Model Advisor Check DO-178C/DO-331 IEC 61508, IEC 62304,
ISO 26262, EN 50128

Check ID in R2018b

Check MATLAB
Function metrics

mathworks.do178.himl_
0003

mathworks.iec61508.hi
ml_0003

mathworks.hism.himl_0
003

Check MATLAB Code
Analyzer messages

mathworks.do178.himl_
0004

mathworks.iec61508.hi
ml_0004

mathworks.hism.himl_0
004

Check state machine
type of Stateflow charts

mathworks.do178.hisf_0
001

mathworks.iec61508.his
f_0001

mathworks.hism.hisf_00
01

Check Stateflow charts
for ordering of states
and transitions

mathworks.do178.hisf_0
002

mathworks.do178.hisf_0
002

mathworks.hism.hisf_00
02

Check for Strong Data
Typing with Simulink
I/O

mathworks.iec61508.St
ateflowProperUsage

mathworks.iec61508.St
ateflowProperUsage

mathworks.hism.hisf_00
09

Check Stateflow
debugging options

mathworks.do178.hisf_0
011

mathworks.do178.hisf_0
011

mathworks.hism.hisf_00
11

Check Stateflow charts
for transition paths that
cross parallel state
boundaries

mathworks.do178.hisf_0
013

mathworks.iec61508.his
f_0013

mathworks.hism.hisf_00
13

Check Stateflow charts
for strong data typing

mathworks.do178.hisf_0
015

mathworks.iec61508.his
f_0015

mathworks.hism.hisf_00
15

Check usage of shift
operations for Stateflow
data

mathworks.do178.hisf_0
064

mathworks.iec61508.his
f_0064

mathworks.hism.hisf_00
64

Check assignment
operations in Stateflow
charts

mathworks.do178.hisf_0
065

mathworks.iec61508.his
f_0065

mathworks.hism.hisf_00
65

Check Stateflow charts
for unary operators

mathworks.do178.hisf_0
211

mathworks.iec61508.his
f_0211

mathworks.hism.hisf_02
11

Check safety-related
diagnostic settings for
data store memory

mathworks.do178.Data
StoreMemoryDiagnostic
sSet

mathworks.do178.Data
StoreMemoryDiagnostic
sSet'

mathworks.hism.hisl_00
13

Check for inconsistent
vector indexing
methods

mathworks.do178.hisl_0
021

mathworks.iec61508.his
l_0021

mathworks.hism.hisl_00
21

Check for variant blocks
with 'Generate
preprocessor
conditionals' active

mathworks.do178.Varia
ntBlock

mathworks.do178.Varia
ntBlock

mathworks.hism.hisl_00
23

Check for root Inports
with missing properties

mathworks.iec61508.Ro
otLevelInports

mathworks.iec61508.Ro
otLevelInports

mathworks.hism.hisl_00
24

Check for root Inports
with missing range
definitions

mathworks.iec61508.In
portRange

mathworks.iec61508.In
portRange

mathworks.hism.hisl_00
25
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Model Advisor Check DO-178C/DO-331 IEC 61508, IEC 62304,
ISO 26262, EN 50128

Check ID in R2018b

Check for root Outports
with missing range
definitions

mathworks.iec61508.Ou
tportRange

mathworks.iec61508.Ou
tportRange

mathworks.hism.hisl_00
26

Check model object
names

mathworks.do178.hisl_0
032

mathworks.iec61508.his
l_0032

mathworks.hism.hisl_00
32

Check usage of lookup
table blocks

mathworks.do178.LUTR
angeCheckCode

mathworks.do178.LUTR
angeCheckCode

mathworks.hism.hisl_00
33

Check usage of Signal
Routing blocks

mathworks.do178.Signa
lRoutingBlockUsage

mathworks.iec61508.Si
gnalRoutingBlockUsage

mathworks.hism.hisl_00
34

Check safety-related
diagnostic settings for
saving

mathworks.do178.Savin
gDiagnosticsSet

mathworks.do178.Savin
gDiagnosticsSet

mathworks.hism.hisl_00
36

Check safety-related
model referencing
settings

mathworks.do178.Mdlre
fOptSet

mathworks.do178.Mdlre
fOptSet

mathworks.hism.hisl_00
37

Check safety-related
solver settings for
simulation time

mathworks.iec61508.Si
mulationTimeOptions

mathworks.iec61508.Si
mulationTimeOptions

mathworks.hism.hisl_00
40

Check safety-related
solver settings for
solver options

mathworks.iec61508.his
l_0041

mathworks.iec61508.his
l_0041

mathworks.hism.hisl_00
41

Check safety-related
solver settings for
tasking and sample-time

mathworks.do178.hisl_0
042

mathworks.iec61508.his
l_0042

mathworks.hism.hisl_00
42

Check safety-related
diagnostic settings for
solvers

mathworks.do178.Solve
rDiagnosticsSet

mathworks.do178.Solve
rDiagnosticsSet

mathworks.hism.hisl_00
43

Check safety-related
diagnostic settings for
sample time

mathworks.do178.Samp
leTimeDiagnosticsSet

mathworks.do178.Samp
leTimeDiagnosticsSet

mathworks.hism.hisl_00
44

Check safety-related
optimization settings for
loop unrolling threshold

mathworks.iec61508.his
l_0051

mathworks.iec61508.his
l_0051

mathworks.hism.hisl_00
51

Check Stateflow charts
for uniquely defined
data objects

mathworks.do178.hisl_0
061

mathworks.do178.hisl_0
061

mathworks.hism.hisl_00
61

Check for model
elements that do not
link to requirements

mathworks.do178.Requi
rementInfo

mathworks.iec61508.Re
quirementInfo

mathworks.hism.hisl_00
70

Check safety-related
diagnostic settings for
compatibility

mathworks.do178.Comp
atibilityDiagnosticsSet

mathworks.do178.Comp
atibilityDiagnosticsSet

mathworks.hism.hisl_03
01

R2018b
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Model Advisor Check DO-178C/DO-331 IEC 61508, IEC 62304,
ISO 26262, EN 50128

Check ID in R2018b

Check safety-related
diagnostic settings for
parameters

mathworks.do178.Data
ValidityParamDiagnostic
sSet

mathworks.do178.Data
ValidityParamDiagnostic
sSet

mathworks.hism.hisl_03
02

Check safety-related
diagnostic settings for
Merge blocks

mathworks.do178.hisl_0
303

mathworks.iec61508.his
l_0303

mathworks.hism.hisl_03
03

Check safety-related
diagnostic settings for
model initialization

mathworicsSet mathworks.do178.InitDi
agnosticsSet

mathworks.hism.hisl_03
04

Check safety-related
diagnostic settings for
data used for debugging

mathworks.do178.Data
ValidityDebugDiagnostic
sSet

mathworks.do178.Data
ValidityDebugDiagnostic
sSet

mathworks.hism.hisl_03
05

Check safety-related
diagnostic settings for
signal connectivity

mathworks.do178.Conn
ectivitySignalsDiagnosti
csSet

mathworks.do178.Conn
ectivitySignalsDiagnosti
csSet

mathworks.hism.hisl_03
06

Check safety-related
diagnostic settings for
bus connectivity

mathworks.do178.Conn
ectivityBussesDiagnosti
csSet

mathworks.do178.Conn
ectivityBussesDiagnosti
csSet

mathworks.hism.hisl_03
07

Check safety-related
diagnostic settings that
apply to function-call
connectivity

mathworks.do178.FcnC
allDiagnosticsSet

mathworks.do178.FcnC
allDiagnosticsSet

mathworks.hism.hisl_03
08

Check safety-related
diagnostic settings for
type conversions

mathworks.do178.Type
ConversionDiagnosticsS
et

mathworks.iec61508.his
l_0309

mathworks.hism.hisl_03
09

Check safety-related
diagnostic settings for
model referencing

mathworks.do178.Mdlre
fDiagnosticsSet

mathworks.do178.Mdlre
fDiagnosticsSet

mathworks.hism.hisl_03
10

Check safety-related
diagnostic settings for
Stateflow

mathworks.do178.hisl_0
311

mathworks.iec61508.his
l_0311

mathworks.hism.hisl_03
11

In R2018b, the following High-Integrity Systems Modeling checks are split into multiple checks based
on functionality.

Model Advisor Check Split Check Titles Check ID
Check usage of Math
Operations blocks

Check usage of Abs blocks mathworks.hism.hisl_0001
Check usage of Math Function
blocks (rem and reciprocal
functions)

mathworks.hism.hisl_0002

Check usage of Math Function
blocks (log and log10 functions)

mathworks.hism.hisl_0004

Check usage of Assignment
blocks

mathworks.hism.hisl_0029
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Model Advisor Check Split Check Titles Check ID
Check usage of Logic and Bit
Operations blocks

Check for Relational Operator
blocks that equate floating-point
types

mathworks.hism.hisl_0016

Check usage of Relational
Operator blocks

mathworks.hism.hisl_0017

Check usage of Logical
Operator blocks

mathworks.hism.hisl_0018

Check usage of Ports and
Subsystems blocks

Check usage of While Iterator
blocks

mathworks.hism.hisl_0006

Check sample time-dependent
blocks

mathworks.hism.hisl_0007

Check usage of For Iterator
blocks

mathworks.hism.hisl_0008

Check usage of If blocks and If
Action Subsystem blocks

mathworks.hism.hisl_0010

Check usage Switch Case blocks
and Switch Case Action
Subsystem blocks

mathworks.hism.hisl_0011

Check safety-related code
generation settings

Check safety-related code
generation settings for
comments

mathworks.hism.hisl_0038

Check safety-related code
generation interface settings

mathworks.hism.hisl_0039

Check safety-related code
generation settings for code
style

mathworks.hism.hisl_0047

Check safety-related code
generation symbols settings

mathworks.hism.hisl_0049

Check usage of Stateflow
constructs

Check for Strong Data Typing
with Simulink I/O

mathworks.hism.hisf_0009

Check Stateflow charts for
ordering of states and
transitions

mathworks.hism.hisf_0002

Check Stateflow debugging
options

mathworks.hism.hisf_0011

Check Stateflow charts for
uniquely defined data objects

mathworks.hism.hisl_0061

Check safety-related
optimization settings

Check safety-related
optimization settings for logic
signals

mathworks.hism.hisl_0045

Check safety-related block
reduction optimization settings

mathworks.hism.hisl_0046

R2018b
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Model Advisor Check Split Check Titles Check ID
Check safety-related
optimization settings for
application lifespan

mathworks.hism.hisl_0048

Check safety-related
optimization settings for data
initialization

mathworks.hism.hisl_0052

Check safety-related
optimization settings for data
type conversions

mathworks.hism.hisl_0053

Check safety-related
optimization settings for
division arithmetic exceptions

mathworks.hism.hisl_0054

The following table includes new checks for High-Integrity Systems Modeling in R2018b.

Model Advisor Check Check ID
Check usage of standardized MATLAB function
headers

mathworks.hism.himl_0001

Check if/elseif/else patterns in MATLAB Function
blocks

mathworks.hism.himl_0006

Check switch statements in MATLAB Function
blocks

mathworks.hism.himl_0007

Check usage of relational operators in MATLAB
Function blocks

mathworks.hism.himl_0008

Check usage of equality operators in MATLAB
Function blocks

mathworks.hism.himl_0009

Check usage of logical operators and functions in
MATLAB Function blocks

mathworks.hism.himl_0010

Check for inappropriate use of transition paths mathworks.hism.hisf_0014
Check naming of ports in Stateflow charts mathworks.hism.hisf_0016
Check scoping of Stateflow data objects mathworks.hism.hisf_0017
Check usage of conditionally executed
subsystems

mathworks.hism.hisl_0012

Check usage of Merge blocks mathworks.hism.hisl_0015
Check usage of Bitwise Operator block mathworks.hism.hisl_0019
Check data types for blocks with index signals mathworks.hism.hisl_0022
Check model file name mathworks.hism.hisl_0031
Check global variables in graphical functions mathworks.hism.hisl_0062
Check for length of user-defined object names mathworks.hism.hisl_0063
Check usage of Gain blocks mathworks.hism.hisl_0066
Check data type of loop control variables mathworks.hism.hisl_0102

For more information, see:
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• Model Checks for DO-178C/DO-331 Standard Compliance
• Model Checks for IEC 61508, IEC 62304, ISO 26262, and EN 50128 Standard Compliance

Compatibility Considerations
The old check IDs continue to work with the Model Advisor API. In a future release, the old check IDs
will be removed. It is recommended that you update your scripts to use the new check IDs.

If you set a default configuration for when the Model Advisor opens, the default configuration
continues to run the old check IDs.

High Integrity Systems Modeling Checks: Use the additional
conditions to check the configuration parameters 
From R2018b, you can use these conditions to check the configuration parameters:

Check Name Parameter Parameter Values
Check safety-related diagnostic
settings for Stateflow

Undirected event broadcasts 'none' | 'warning'
(default) | 'error'

Check passes when value is set
to ‘error’.

Transition action specified
before condition action

'none' | 'warning'
(default) | 'error'

Check passes when value is set
to ‘error’.

Check safety-related diagnostic
settings for sample time

Single task rate transition 'none' (default) |
'warning' | 'error'

Check passes when value is set
to ‘error’.

Tasks with equal priority 'none' | 'warning'
(default) | 'error'

Check passes when value is set
to ‘error’.

Unspecified inheritability of
sample time

'none' | 'warning'
(default) | 'error'

Check passes when value is set
to ‘error’.

MISRA C:2012 and Secure Coding Standards: Improve compliance of
generated code by using updated Model Advisor checks
Modifications to existing Model Advisor checks that you use to verify compliance with MISRA C:2012
and Secure Coding standards are outlined in this table.

R2018b
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Model Advisor Check Description of Change
Check configuration parameters for MISRA
C:2012

Check configuration parameters for secure
coding standards

Checks now analyze the setting for these configuration
parameters:

• External mode
• Undirected event broadcasts
• Compile-time recursion limit for MATLAB

functions
• Enable run-time recursion for MATLAB

functions
Check for blocks not recommended for
MISRA C:2012

Check for blocks not recommended for
secure coding standards

Checks now flag the usage of these blocks in a model
or subsystem:

• Compose String
• Scan String
• String to Double
• String to Single
• To String

Mnemonic Support: Use keyboard shortcuts with Metrics Dashboard
In R2018b, you can use your keyboard to choose from the actions on the Metric Dashboard toolbar.
To enable keyboard shortcuts, on Windows® and Linux® machines, type Alt + M. Mac computers do
not support keyboard shortcuts.

Check Style for Model Advisor: Create checks that generate
interactive reports
In R2018b, the Model Advisor has two new report styles that you can use to view the check results. In
addition to Recommended Action, you can now view the results for some of the Model Advisor
checks by:

• Subsystem. This view organizes the flagged model components by subsystem. The report
provides a recommended action for each flagged issue. You can click the hyperlink path to open
the affected model component in the model editor.
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• Block. This view organizes the flagged model components by block. The report provides a
recommended action for each flagged issue. You can click the hyperlink path to open the affected
model component in the model editor.

R2018b
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In R2018b, new report styles are available for the following Model Advisor checks:

• Identify blocks generating inefficient algorithms
• Check state machine type of Stateflow charts
• Check usage of Gain blocks
• Check for indexing in blocks
• Check for prohibited blocks in discrete controllers
• Check for prohibited sink blocks
• Check positioning and configuration of ports
• Check for matching port and signal names
• Check whether block names appear below blocks
• Check for mixing basic blocks and subsystems
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• Check for unconnected ports and signal lines
• Check position of Trigger and Enable blocks
• Check usage of tunable parameters in blocks
• Check the display attributes of block names
• Check display for port blocks
• Check orientation of Subsystem blocks
• Check usage of Relational Operator blocks
• Check use of Simulink in Stateflow charts
• Check use of default variants
• Check usage of Discrete-Time Integrator block
• Check usage of State names
• Check uniform spaces before and after operators
• Check comments in state actions
• Check prohibited comparison operation of logical type signals
• Check usage of internal transitions in Stateflow states
• Check usage of transition conditions in Stateflow transitions
• Check block orientation
• Check usage of parentheses in Stateflow transitions
• Check boolean operations in condition labels
• Check usage of transition conditions in Stateflow transitions
• Check prohibited use of operation expressions in array indices
• Check if each action in state label ends with a semicolon
• Check prohibited combination of state action and flow chart
• Check updates to variables used in state transition conditions
• Check condition actions in Stateflow transitions
• Check starting point of internal transition in Stateflow
• Check usage of Lookup Tables
• Check for parentheses in Fcn block expressions
• Check for blocks not supported for row-major code generation
• Identify TLC S-Functions with unset array layout
• Check input and output datatype for Switch blocks
• Check type setting by data objects
• Check for the Saturation and Saturation Dynamic blocks that perform type casting
• Check usage of fixed-point data type with non-zero bias

To apply the new report formats to your custom Model Advisor checks, use the classes and function
listed in this table.
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Class Description
ModelAdvisor.Check New method setResultDetails associates

ResultDetailObjs and ElementResults with
the check (CheckObj) in the check callback
function.

New property
ModelAdvisor.Check.ResultDetails stores
the ResultDetailObjs.

In the setCallbackFcn method, input argument
'DetailStyle' specifies the callback function
for the new report style. Define the new
'DetailStyle' callback function type in the
ModelAdvisor.Check.CallbackStyle
property.

ModelAdvisor.ResultDetail Defines the result detail objects for a specific
check object. Each object stores the result details
for one model element, such as a block that
violates a check.

Functionality Being Removed or Changed
Instances of slmetric.metric.Result for the mathworks.metrics.CloneContent and
mathworks.metrics.LibraryContent metrics contain these differences between R2018a and
R2018b:

• Previously, for the mathworks.metrics.CloneContent metric, the Value property provided
the number of components in a clone. The Measures property was not applicable. In R2018b, the
Value property provides the fraction of the total number of subcomponents that are clones. The
Measures property is a vector containing the number of clones, total number of components, and
the clone group number.

• Previously, for the mathworks.metrics.LibraryContent metric, the Value property provided
the number of components involved in a library, excluding clones. The Measures property was not
applicable. In R2018b, the Value property provides the fraction of the total number of
components that are linked-library blocks. The Measures property is a vector containing the
number of linked-library blocks and total number of components.

The Metrics Dashboard incorporates these changes. Previously, the Library Reuse widget displayed
percentages that were a combination of five metrics. The widget directly used the Clone detection
(mathworks.metrics.CloneDetection) and Library link (mathworks.metrics.LibraryCount)
metrics. To calculate percentages, the widget indirectly used the MATLAB Function count
(mathworks.metrics.MatlabFunctionCount), the Chart count
(mathworks.metrics.StateflowChartCount), and the Subsystem count
(mathworks.metrics.SubSystemCount) metrics.

In R2018b,The Library Reuse widget is Potential Reuse and Actual Reuse bars. The Potential
Reuse bar displays the mathworks.metrics.CloneContent Value as a percentage. The Actual
Reuse bar displays the mathworks.metrics.LibraryContent Value as a percentage.

For the mathworks.metrics.CloneContent and mathworks.metrics.LibraryCount metrics,
changing the slmetric.metric.Result Measures and Values properties supports displaying
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metric threshold values on the Metrics Dashboard because you specify metric thresholds on a single
metric and not on a combination of metrics. Metric thresholds is a new R2018b feature. For more
information, see Customize Metrics Dashboard Layout and Functionality.

R2018b
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Version: 4.1

New Features

Bug Fixes
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Additional Checks for MAAB 3.0 and JMAAB 4.0 Guidelines: Automate
checking for MAAB 3.0 guidelines for Simulink, Stateflow, Variant
Subsystems, and MATLAB Function Blocks and JMAAB 4.0 guidelines
MAAB Modeling Checks

Use these new checks to verify compliance with MathWorks Automotive Advisory Board (MAAB)
guidelines. To execute these checks, open Model Advisor (Simulink) and select By Task > Modeling
Standards for MAAB.

For information about MAAB® guidelines, see Model Advisor Checks for MAAB Guidelines (Simulink).

By Task >
Modeling
Standards for
MAAB subfolder

Model Advisor Check Addresses Guideline

Naming Convention Check Simulink bus signal names na_0030: Usable characters for
Simulink Bus names

Model Architecture Check unused ports in Variant Subsystems na_0020: Number of inputs to
variant subsystems

Model Architecture Check use of default variants na_0036: Default variant
Model Architecture Check use of single variable variant

conditionals
na_0037: Use of single variable
variant conditionals

Model Architecture Check number of Stateflow states per
container

na_0040: Number of states per
container

Simulink Check fundamental logical and numerical
operations

na_0002: Appropriate
implementation of fundamental
logical and numerical
operations

Simulink Check usage of merge blocks na_0032: Use of merge blocks
Simulink Check logical expressions in 'If' blocks na_0003: Simple logical

expressions in If Condition
block

Stateflow Check nested states in Stateflow charts na_0038: Levels in Stateflow
charts

Stateflow Check use of Simulink in Stateflow charts na_0039: Use of Simulink in
Stateflow charts

MATLAB Functions Check usage of reserved keywords in
Simulink

na_0019: Restricted Variable
Names

MATLAB Functions Check usage of character vector inside
MATLAB Function block

na_0021: Strings

MATLAB Functions Check Recommended patterns for Switch/
Case Statements

na_0022: Recommended
patterns for Switch/Case
statements

Modifications to existing MAAB checks are outlined in this table.

R2018a

7-2

https://www.mathworks.com/help/releases/R2018a/simulink/ug/select-and-run-model-advisor-checks.html
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/available-model-advisor-checks.html
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/mathworks-automotive-advisory-board-checks.html#mw_bdbd9ffd-2659-4245-a6ae-afe12449a827
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0030usablecharactersforsimulinkbusnames.html
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0030usablecharactersforsimulinkbusnames.html
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/mathworks-automotive-advisory-board-checks.html#mw_b79f3697-62d4-4b1f-a1a1-85565572d2c9
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0020numberofinputstovariantsubsystems.html
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0020numberofinputstovariantsubsystems.html
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/mathworks-automotive-advisory-board-checks.html#mw_b0ba3b1f-94c2-40fc-9d4c-a58694ad972d
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0036defaultvariant.html
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/mathworks-automotive-advisory-board-checks.html#mw_bd29fead-d44e-43e4-bf4b-546142b5a69c
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/mathworks-automotive-advisory-board-checks.html#mw_bd29fead-d44e-43e4-bf4b-546142b5a69c
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0037useofsinglevariablevariantconditionals.html
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0037useofsinglevariablevariantconditionals.html
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/mathworks-automotive-advisory-board-checks.html#mw_0748a7f8-efba-4f6a-9b93-988e9be12a36
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/mathworks-automotive-advisory-board-checks.html#mw_0748a7f8-efba-4f6a-9b93-988e9be12a36
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0040numberofstatespercontainer.html
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0040numberofstatespercontainer.html
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/mathworks-automotive-advisory-board-checks.html#mw_783da046-c828-41eb-a55e-3b3e7a28f86f
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/mathworks-automotive-advisory-board-checks.html#mw_783da046-c828-41eb-a55e-3b3e7a28f86f
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0002appropriateimplementationoffundamentallogicalandnumericaloperations.html
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0002appropriateimplementationoffundamentallogicalandnumericaloperations.html
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0002appropriateimplementationoffundamentallogicalandnumericaloperations.html
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0002appropriateimplementationoffundamentallogicalandnumericaloperations.html
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/mathworks-automotive-advisory-board-checks.html#mw_5fc4cfe9-58bc-4c22-a53f-30ed930372b0
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0032useofmergeblocks.html
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/mathworks-automotive-advisory-board-checks.html#mw_dd16a788-4d0f-4de8-948c-ea686df77715
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0003simplelogicalexpressionsinifconditionblock.html
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0003simplelogicalexpressionsinifconditionblock.html
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0003simplelogicalexpressionsinifconditionblock.html
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/mathworks-automotive-advisory-board-checks.html#mw_44d47ec3-96fa-4756-a76b-c958dd91ec43
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0038levelsinstateflowcharts.html
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0038levelsinstateflowcharts.html
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/mathworks-automotive-advisory-board-checks.html#mw_e7d54a5d-c878-4760-8600-a30b7f1c6fa6
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0039useofsimulinkinstateflowcharts.html
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0039useofsimulinkinstateflowcharts.html
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/mathworks-automotive-advisory-board-checks.html#mw_f3c5361e-64b3-4f66-89e1-a8840fd7a5d9
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/mathworks-automotive-advisory-board-checks.html#mw_f3c5361e-64b3-4f66-89e1-a8840fd7a5d9
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0019restrictedvariablenames.html
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0019restrictedvariablenames.html
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/mathworks-automotive-advisory-board-checks.html#mw_bb52c7d8-a6e3-4ac2-8a2b-e490de980ef9
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/mathworks-automotive-advisory-board-checks.html#mw_bb52c7d8-a6e3-4ac2-8a2b-e490de980ef9
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0021strings.html
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/mathworks-automotive-advisory-board-checks.html#mw_424a1617-8f0f-49d8-b25b-dda3323c1847
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/mathworks-automotive-advisory-board-checks.html#mw_424a1617-8f0f-49d8-b25b-dda3323c1847
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0022recommendedpatternsforswitchcasestatements.html
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0022recommendedpatternsforswitchcasestatements.html
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/maab/na_0022recommendedpatternsforswitchcasestatements.html


Model Advisor Check Description of Change
Check entry formatting in State blocks in
Stateflow charts

Check for mismatches between names of
Stateflow ports and associated signals

Check for Strong Data Typing with Simulink
I/O

Check for indexing in blocks

Check for MATLAB expressions in Stateflow
charts

Check transition orientations in flow charts

Check usage of exclusive and default states
in state machines

Check transition actions in Stateflow charts

Check for unary minus operations on
unsigned integers in Stateflow charts

Check for equality operations between
floating-point expressions in Stateflow
charts

Check return value assignments of graphical
functions in Stateflow charts

Check usage of return values from a
graphical function in Stateflow charts

Check default transition placement in
Stateflow charts

Check for pointers in Stateflow charts

Check for event broadcasts in Stateflow
charts

Check for bitwise operations in Stateflow
charts

Check for comparison operations in
Stateflow charts

These checks now require a Stateflow license. These
checks are included in the Model Advisor interface
only when a Stateflow license is detected.

Check the display attributes of block names You can now use the input parameters in the Model
Advisor Configuration Editor to customize the blocks
and masks to be analyzed the check.
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Model Advisor Check Description of Change
Check position of Trigger and Enable blocks Check now verifies that For Each, For Iterator, and

While Iterator blocks are in a uniform location on the
subsystem diagram.

JMAAB Modeling Checks

Checks that verify compliance with Japan MATLAB Automotive Advisory Board (JMAAB) guidelines
are now available in the Model Advisor under the new menu item By Task > Modeling Standards
for JMAAB.

The following table identifies new checks to verify compliance with JMAAB 4.0 guidelines. For
information about JMAAB guidelines, see Model Advisor Checks for MAAB Guidelines (Simulink).

By Task > Modeling
Standards for JMAAB
Subfolder

Model Advisor Check Addresses Guideline

Simulink Check usage of Discrete-Time Integrator
block

jc_0627: Guideline for using
the Discrete-Time Integrator
block

Simulink Check for blocks with a fixed-point data type
whose bias is not zero

jc_0643: Fixed-point setting

Simulink Check input and output datatype for Switch
blocks

jc_0650: Block input/output
data type with switching
function

Simulink Check input signal data types in product
blocks that perform division

jc_0611: Input signal sign
during product block division

The following table identifies MAAB checks are also applicable to JMAAB 4.0 guidelines. These
checks are available in the Model Advisor (Simulink) under By Task > Modeling Standards for
JMAAB. There are no changes to the check IDs.

By Task > Modeling
Standards for JMAAB
Subfolder

Model Advisor Check

Naming Conventions Check file names
Check folder names
Check subsystem names
Check port block names
Check character usage in signal labels
Check character usage in block names

Model Architecture Check for mixing basic blocks and subsystems
Model Configuration
Options

Check Implement logic signals as Boolean data (vs. double)

Simulink Check for Simulink diagrams using nonstandard display attributes
Check font formatting
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By Task > Modeling
Standards for JMAAB
Subfolder

Model Advisor Check

Check positioning and configuration of ports
Check whether block names appear below blocks
Check the display attributes of block names
Check position of Trigger and Enable blocks
Check for nondefault block attributes
Check Trigger and Enable block names
Check signal line labels
Check for propagated signal labels
Check for unconnected ports and signal lines
Check for prohibited blocks in discrete controllers
Check for prohibited sink blocks
Check usage of Switch blocks
Check usage of Relational Operator blocks
Check for indexing in blocks
Check usage of tunable parameters in blocks
Check orientation of Subsystem blocks

Stateflow Check transition orientations in flow charts
Check return value assignments of graphical functions in Stateflow charts
Check default transition placement in Stateflow charts
Check for Strong Data Typing with Simulink I/O
Check Stateflow data objects with local scope
Check usage of return values from a graphical function in Stateflow charts
Check for MATLAB expressions in Stateflow charts
Check for pointers in Stateflow charts
Check for event broadcasts in Stateflow charts
Check transition actions in Stateflow charts
Check for bitwise operations in Stateflow charts
Check for unary minus operations on unsigned integers in Stateflow charts
Check for comparison operations in Stateflow charts
Check for mismatches between names of Stateflow ports and associated
signals

MATLAB Function Check input and output settings of MATLAB Functions
Check MATLAB Function metrics
Check MATLAB code for global variables
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Block Constraint Authoring with Edit-Time: Define checks for
supported or unsupported blocks and parameters while editing
In R2018a, there are seven new classes and two new functions that you can use to create block and
parameter constraints. You can use the sl_customization function template to create basic Model
Advisor checks. These checks include these constraints and a check algorithm callback. You can
check your model as you edit or run the checks interactively after you complete your model design.

The new classes and their descriptions are in the table.

Class Description
Advisor.authoring.PositiveBl
ockParameterConstraint

Check for supported block parameter values.

Advisor.authoring.NegativeBl
ockParameterConstraint

Check for unsupported block parameter values.

Advisor.authoring.PositiveMo
delParameterConstraint

Check for supported model parameter values.

Advisor.authoring.NegativeMo
delParameterConstraint

Check for unsupported model parameter values.

Advisor.authoring.PostiveBlo
ckTypeConstraint

Check for supported blocks.

Advisor.authoring.NegativeBl
ockTypeConstraint

Check for unsupported blocks.

Advisor.authoring.CompositeC
onstraint

Check whether blocks or parameters meet a combination of
constraints.

The new functions and their descriptions are in the table.

Function Description
Advisor.authoring.generateBl
ockConstraintsDataFile

Generate XML data file for custom check for block
constraints.

Advisor.authoring.createBloc
kConstraintCheck

Create Model Advisor check for registering block constraints.

You can also create constraints that check for pre-requisite constraints before checking the actual
constraint. For more information, see Define Checks for Supported or Unsupported Blocks and
Parameters.

Clone Refactoring Workflow: Apply multiple refactoring steps to the
same model
In R2017b, for each refactoring step, the Identify Modeling Clones tool created a new model. In
R2018a, you can apply multiple refactoring steps to the same model. For each step, the tool creates a
back-up model. The back-up models are in the folder that has the prefix m2m_ plus the model name.
For a single model, this enhanced functionality makes it easier for you to replace clones with links to
library blocks. For more information, see Enable Component Reuse by Using Clone Detection.
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Automatic Refactoring for Similar Clones: Add masks to similar clones
and refactor model
In R2017b, you could use the Identify Modeling Clones tool to identify exact clones and replace them
with links to library blocks. The tool also identified similar clones (that is, clones that had identical
block types and connections but different parameter settings or values).The tool identified similar and
exact clones as part of different steps.

In R2018a, for similar clones, the Identify Modeling Clones tool creates a masked library subsystem.
The refactored model contains links from the clone instances to this masked library subsystem. The
tool identifies similar and exact clones as part of the same steps. You specify which clones you want
to detect by setting the value of the Maximum number of different parameters parameter. A
value of 0 indicates that you want the tool to identify only exact clones.

Replacing clones with links to library blocks enables component reuse. If you have Simulink Coder or
Embedded Coder software, you can generate reusable code for library subsystems. For more
information, see Enable Component Reuse by Using Clone Detection.

Clone Detection Exclusion Editor: Exclude subsystems and referenced
models from clone detection
In R2018a, there is a new Clone Detection Exclusion Editor that you can use to exclude a subsystem
or referenced model from the Identify Modeling Clones tool. For subsystems, right-click the
subsystem and select Identify Modeling Clones > Subsystem and Its Contents > Add to
exclusions. For referenced models, right-click the Model block and select Identify Modeling
Clones > Model Reference > Add to exclusions. You can use the Exclusion Editor to specify a
rationale for excluding subsystems and referenced models and whether to store exclusions in a model
file. For more information, see Enable Component Reuse by Using Clone Detection.

Automatic Data Store Memory Block Elimination: Identify and refactor
Data Store Memory Block blocks with Model Transformer
In R2018a, use the Model Transformer tool to refactor a model to eliminate Data Store Memory, Data
Store Read, and Data Store Write blocks. Eliminating these blocks improves model readability by
making data-dependency explicit. If you have Simulink Coder, eliminating these blocks may improve
the efficiency of the generated code by reducing the number of global variables, the corresponding
reads and writes to these global variables, and stack size. For more information, see Improve Model
Readability by Eliminating Local Data Store Blocks.

Grid Visualization for Metrics: View results of Model Advisor checks in
a grid to identify patterns in results
In R2017b, after collecting metric data by using the Metric Dashboard, you could view results for
High Integrity and MAAB Compliance metrics in tabular format. You viewed this data by clicking the
widgets in the MODELING GUIDELINE COMPLIANCE section.

In R2018a, when you click the High Integrity Compliance and MAAB Compliance widgets, you
can view results in a table or a grid. In the toolbar, you change views by clicking Table or Grid.
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Viewing results in a grid enables you to identify compliance check issues and failure patterns quickly.
The grid contains a row for each model component and a column for each check. The colors in each
grid cell indicate this status.

Color Check Status
Red Fail
Orange Warning
Green Pass
Gray Not run

The colors in the row and column headers indicate the worst status for that component or check. For
example, for a row, if the worst status is a failure, the row header is red.

Placing your cursor over a cell displays the component, check status, and check name. You can click
individual cells to navigate to the corresponding block and identify compliance issues for that block.
To navigate to the corresponding check in the Model Advisor, click a column header. To navigate to
the corresponding model component, click a row header. For more information, see Collect and
Explore Metric Data by Using the Metrics Dashboard.

MathWorks High-Integrity Guidelines and Checks: Verify compliance
with safety standards by using high-integrity checks and guidelines
High-Integrity System Modeling Checks

This table identifies modifications to existing high-integrity system modeling checks.

R2018a
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Model Advisor Check Description of Change
DO-178C/DO-331 checks:

• Check usage of shift operations for
Stateflow data

• Check assignment operations in Stateflow
Charts

• Check state machine type of Stateflow
charts

• Check Stateflow charts for ordering of
states and transitions

• Check Stateflow debugging options
• Check for inconsistent vector indexing

methods
• Check Stateflow charts for strong data

typing
• Check Stateflow charts for unary operators
• Check Stateflow charts for uniquely
defined data objects

IEC 61508, IEC 62304, EN 50128, and ISO
26262 checks:

• Check usage of shift operations for
Stateflow data

• Check assignment operations in Stateflow
Charts

• Check state machine type of Stateflow
charts

• Check Stateflow charts for ordering of
states and transitions

• Check Stateflow debugging options
• Check for inconsistent vector indexing

methods
• Check Stateflow charts for strong data

typing
• Check Stateflow charts for unary operators
• Check Stateflow charts for uniquely
defined data objects

• Display model metrics and complexity
report

Checks require a Stateflow license. These checks are
available in the Model Advisor only when a Stateflow
license is detected.
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Model Advisor Check Description of Change
DO-178C/DO-331: Check for model elements
that do not link to requirements

IEC 61508, IEC 62304, EN 50128, and ISO
26262: Check for model elements that do not
link to requirements

Checks require a Simulink Requirements license.
These checks are avaiable in the Model Advisor only
when a Simulink Requirements license is detected.

Check for blocks not recommended for MISRA
C:2012

Check for blocks not recommended for MISRA
C:2012

Checks analysis now includes the content in library
linked blocks and masked subsystems.

Check for blocks not recommended for C/C++
production code deployment

Check for blocks not recommended for C/C++
production code deployment

Checks analysis now includes the content in library
linked blocks.

High-Integrity Modeling Guidelines

These high-integrity system modeling guidelines are introduced in R2018a:

• hisl_0056: Configuration Parameters > Optimization > Optimize using the specified minimum and
maximum values

• hisl_0066: Usage of Gain blocks
• hisl_0314: Configuration Parameters > Diagnostics > Data Validity > Signals
• hisf_0016: Stateflow port names
• hisf_0017: Stateflow data object scoping

This table identifies removed and modified high-integrity system modeling guidelines. For a complete
list of high-integrity system modeling guidelines, including their applicable Model Advisor checks, see
Model Advisor Checks for High-Integrity Modeling Guidelines (Simulink).

High-Integrity Modeling Guideline Rationale
hisl_0202: Use of data conversion
blocks to improve MISRA C:2012
compliance

Removed - guideline no longer applies. The code generation
process does not produce this MISRA violation in the
generated code.

hisl_0401: Encapsulation of code to
improve MISRA C:2012 compliance

Removed - not a modeling guideline. The guideline
addresses issues in source code external to a model.
Embedded Coder does not directly call assembly language
code.

hisl_0402: Use of custom #pragma to
improve MISRA C:2012 compliance

Removed - not a modeling guideline. The guideline
addresses issues in source code external to a model.

hisl_0403: Use of char data type to
improve MISRA C:2012 compliance

Removed - not a modeling guideline. The guideline
addresses issues in source code external to a model.
Embedded Coder does not directly create data of type char.

R2018a

7-10

https://www.mathworks.com/help/releases/R2018a/slcheck/ref/do-178c-checks.html#bryz4j2-1
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/do-178c-checks.html#bryz4j2-1
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/iec-61508-and-iso-26262-checks.html#br547qz-1
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/iec-61508-and-iso-26262-checks.html#br547qz-1
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/iec-61508-and-iso-26262-checks.html#brlhdal.bsc06fh-1
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/iec-61508-and-iso-26262-checks.html#brlhdal.bsc06fh-1
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/do-178c-checks.html#brlhdcb.bsc06fh-1
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/do-178c-checks.html#brlhdcb.bsc06fh-1
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/iec-61508-and-iso-26262-checks.html#btqhuh9-1
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/iec-61508-and-iso-26262-checks.html#btqhuh9-1
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/do-178c-checks.html#btqhu_h-1
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/do-178c-checks.html#btqhu_h-1
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/hi/code-generation.html#mw_11df4427-dadb-4df9-8783-2965ca1d62eb
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/hi/code-generation.html#mw_11df4427-dadb-4df9-8783-2965ca1d62eb
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/hi/math-operations.html#mw_8c2e7110-da67-43f0-94ec-580d322007a0
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/hi/diagnostics.html#mw_ecaa4001-da3d-462a-a4f3-166bbd4674ac
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/hi/chart-architecture.html#mw_4c7b6144-da5c-4bc9-809c-d44221a2a55a
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/hi/chart-architecture.html#mw_f91aae8d-3782-49b7-8a48-e4b67c0ee0cc
https://www.mathworks.com/help/releases/R2018a/simulink/mdl_gd/hi/model-advisor-checks-for-high-integrity-modeling-guidelines.html


High-Integrity Modeling Guideline Rationale
hisl_0055: Prioritization of code
generation objectives for high-
integrity systems

Removed - guideline is redundant. Model configuration
parameter considerations are covered by existing high-
integrity systems guidelines.

hisl_0042: Configuration Parameters
> Solver > Tasking and sample time
options

Removed criteria A, "Periodic sample time constraint to
specified and assign values to Sample time properties".
Criteria A no longer applies because there is no known
safety issue with the periodic sample time constraint values.

Change affects checks:

• DO-178C/DO-331: Check safety-related solver settings for
tasking and sample-time

• EC 61508, IEC 62304, EN 50128, and ISO 26262: Check
safety-related solver settings for tasking and sample-time

hisl_0310: Configuration Parameters
> Diagnostics > Model Referencing

Set configuration parameter Model block version
mismatch to none. This change reflects behavior of the
corresponding Model Advisor check.

hisl_0016: Usage of blocks that
compute relational operators

Add the If block to the list of blocks that compute relational
operations. This change reflects behavior of Model Advisor
check.

hisl_0017: Usage of blocks that
compute relational operators (2)

Add Rational B, "For Relational Operator blocks, ensure that
all input signals are of the same data type". This change
reflects behavior of the corresponding Model Advisor check.

hisl_0046: Configuration Parameters
> Code Generation > Optimization >
Block reduction

hisl_0051: Configuration Parameters
> Code Generation > Optimization >
Loop unrolling threshold

hisl_0052: Configuration Parameters
> Code Generation > Optimization >
Data initialization

hisl_0053: Configuration Parameters
> Code Generation > Optimization >
Remove code from floating-point to
integer conversions that wraps out-of-
range values

hisl_0054: Configuration Parameters
> Code Generation > Optimization >
Remove code that protects against
division arithmetic exceptions

In R2018a,the Optimization pane in the Configuration
Parameters dialog box moved to Code Generation >
Optimization. The title of and support documentation for
the affected guidelines were updated to reflect this change.
Where applicable, the Model Advisor checks were updated to
reflect this change.
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High-Integrity Modeling Guideline Rationale
hisl_0045: Configuration Parameters
> Code Generation > Optimization >
Implement logic signals as Boolean
data (vs. double)

In R2018a, configuration parameter Implement logic
signals as Boolean data (vs. double) moved to the new
Math and Data Types pane in the Configuration
Parameters dialog box. The title of and support
documentation for the guideline were updated to reflect this
change.

hisl_0019: Usage of Bitwise Operator
block

Remove Criteria B, "Choose an output data type that
represents zero exactly" from the guideline. Criteria B does
not apply because the Bitwise Operator block, by design,
accepts only signed or unsigned integer to produce the
output data type that represents zero exactly. It does not
accept other data types.

hisl_0102: Data type of loop control
variables to improve MISRA C:2012
compliance

Remove While loops and While Iterator blocks. These are not
recommended for safety critical systems because an infinite
loop can occur. Guideline does not have corresponding
checks.

hisl_0031: File and folder names Remove folder naming recommendations because there is no
known safety issue with folder names. Guideline title was
updated accordingly.

MISRA C: 2012 Modeling Checks: Improve compliance of generated
code by using MISRA C:2012 standards checks
Use this new check to verify compliance of your generated code with MISRA C:2012 standards. To
execute this check, open Model Advisor (Simulink) and select By Task > Modeling Standards for
MISRA C:2012

Model Advisor Check Description Addresses
Standards

Check bus object names that are
used as element names

Check now identifies Simulink.Bus object
names that are used as Simulink.Bus
element names.

• MISRA
C:2012 Rule
5.6

• MISRA AC
AGC Rule 5.3

Modifications to existing compliance checks are outlined in this table.

Model Advisor Check Description of Change
Check for bitwise operations on signed
integers

The check assumes that code is generated for the
whole model. When code is generated by a subsystem
build or export functions, the check can produce
incorrect results.

Check for blocks not recommended for
MISRA C:2012

Check for blocks not recommended for C/C+
+ production code deployment

Checks analysis now includes the content in library
linked blocks and masked subsystems.
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For information about MISRA C® versions and updates, see MISRA C Guidelines.

Secure Coding Modeling Checks: Update to Secure Coding compliance
checks
Modifications to existing secure coding checks are outlined in this table.

Model Advisor Check Description of Change
Check for bitwise operations on signed
integers

Check now identifies blocks in the top model only.

Check for blocks not recommended for C/C+
+ production code deployment

Checks analysis now includes the content in library
linked blocks and masked subsystems.

For information about MISRA C versions and updates, see MISRA C Guidelines.

Enhanced Edit-Time Checking Support: Edit-time checking for blocks
not recommended for C/C++ production code deployment
In R2017b, you could run the Model Advisor check mathworks.codegen.PCGSupport to identify
blocks that were not supported by code generation or were not recommended for C/C++ production
code deployment. In R2018a, you can use edit-time checking to identify these blocks earlier on in the
design process. For more information, see Check for Compliance Using the Model Advisor and Edit-
Time Checking.

Model Advisor Support for Inactive Variants: Run Model Advisor
checks on active and inactive variants and generate report
In R2017b, you could run Model Advisor checks only on the active variant of a model. You had to
manually activate the various variant choices to run the Model Advisor on different variants.

In R2018a, you can run Model Advisor checks on valid variant configurations. Use the Variant
Manager to define these configurations. Set the new Advisor.Application class property
AnalyzeVariants to true. The Model Advisor generates a separate HTML report of check results
for each variant configuration.

Metric Engine Improvement: Collect and analyze metric data faster
In R2018a, for a given analysis, the metric engine collects and analyzes metric data faster than in
R2017b. Also, when you open the Metric Dashboard for a model in which you previously generated
results, the results are now loaded more quickly. For more information, see Collect Model Metrics.

Model Metric APIs: Removed Model block architectural component
In R2018a, for a specified metric engine object, you can no longer collect metric data for Model
blocks. However, you can still collect metric data for these Simulink objects:

• Model
• Subsystem block
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https://www.mathworks.com/help/releases/R2016a/ecoder/ug/developing-models-and-code-that-comply-with-misra-c-guidelines.html
https://www.mathworks.com/help/releases/R2018a/slcheck/ug/overview.html
https://www.mathworks.com/help/releases/R2018a/slcheck/ug/overview.html
https://www.mathworks.com/help/releases/R2018a/slcheck/ref/advisor.application-class.html
https://www.mathworks.com/help/releases/R2018a/slcheck/collect-model-metric-data-1.html


• Chart
• MATLAB Function block
• Protected model

For custom metrics, in your algorithm method, you can no longer specify a ComponentScope that
is a Model block.

Eliminating the Model block component does not mean that you are missing valuable data. The
parent model AggregatedValue includes the data for the Model block AggregatedValue. The
model block Value did not contain data.

For example, in R2017b, for the sldemo_mdlref_basic model, these are the results for the
mathworks.metrics.SimulinkBlockCount.

ComponentPath: sldemo_mdlref_basic
  Value: 12
  AggregatedValue: 66
ComponentPath: sldemo_mdlref_basic/CounterA
  Value: NaN
  AggregatedValue: 18
ComponentPath: sldemo_mdlref_basic/CounterB
  Value: NaN
  AggregatedValue: 18
ComponentPath: sldemo_mdlref_basic/CounterC
  Value: NaN
  AggregatedValue: 18
ComponentPath: sldemo_mdlref_basic/More Info
  Value: 0
  AggregatedValue: 0
ComponentPath: sldemo_mdlref_counter
  Value: 18
  AggregatedValue: 18 

The three instances of the referenced model sldemo_mdlref_counter (that is Counter A,
Counter B, and Counter C) have results. They have a Value of NaN and the
sldemo_mdlref_basic results include their aggregated values.

In R2018a, for the sldemo_mdlref_basic model, these are the results for the
mathworks.metrics.SimulinkBlockCount metric:

ComponentPath: sldemo_mdlref_basic
   Value: 12
   AggregatedValue: 66
ComponentPath: sldemo_mdlref_basic/More Info
  Value: 0
  AggregatedValue: 0
ComponentPath: sldemo_mdlref_counter
  Value: 18
  AggregatedValue: 18

The results do not contain the individual instances of sldemo_mdlref_counter. The aggregated
value of sldemo_mdlref_basic results still includes their aggregated values.
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Simulink Verification and Validation Packaging: Moved compliance
checking, model metrics, clone detection and refactoring, edit-time
checking and model transformer to Simulink Check
As of R2017b, Simulink Verification and Validation™ transitions to three new products, Simulink
Requirements, Simulink Coverage, and Simulink Check.

• Requirements traceability and Requirements Management Interface (RMI) functionality have
moved to the Simulink Requirements product.

• Model and generated code coverage functionality, and component verification functions such as
slvnvmakeharness, have moved to the Simulink Coverage product.

• Compliance checking, model metrics, clone detection and refactoring, and model transformer
functionality have moved to the Simulink Check product.

Metrics Dashboard: Collect and view metric data for quality
assessment
The Metrics Dashboard collects and integrates quality metric data from multiple Model-Based Design
tools to provide you with an assessment of your project quality status. In R2017b, by using the
dashboard, you can collect and explore metric data for:

• Model size
• Modeling guidelines compliance
• Model componentization and clone detection

To explore the data in more detail, click an individual metric. For your selected metric, a table
displays the value, aggregated value, and measures (if applicable) at the model component level.
From the table, the dashboard provides traceability and hyperlinks to the data source so that you can
get detailed results and recommended actions for troubleshooting issues.

Open the Metrics Dashboard from the model editor window by selecting Analysis > Metrics
Dashboard. Or, at the command line, enter metricsdashboard(system).

For more information, see Collect and Explore Metric Data by Using the Metrics Dashboard.

MathWorks High-Integrity Guidelines and Checks: Verify compliance
with safety standards by using high-integrity checks and guidelines
Categorization of the Model Advisor Checks for High-Integrity Systems

You can use the Model Advisor to check compliance with safety standards by using the high-integrity
checks. To execute these checks, Open the Model Advisor (Simulink) and select the safety standard:

• By Task > Modeling Standards for DO-178/DO-331 > High-Integrity Systems
• By Task > Modeling Standards for EN 50128 > High-Integrity Systems
• By Task > Modeling Standards for IEC 61508 > High-Integrity Systems
• By Task > Modeling Standards for IEC 62304 > High-Integrity Systems
• By Task > Modeling Standards for ISO 26262 > High-Integrity Systems

R2017b
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The high-integrity checks are categorized into these subgroups:

• Simulink
• Stateflow
• MATLAB
• Configuration
• Requirements
• Code

High-Integrity Model Advisor Checks for DO-178C/DO-331 Standards

The following table identifies the Model Advisor checks that have been introduced in R2017b to check
compliance with safety standards DO-178C/DO-331.

These checks are available at By Task > Modeling Standards for DO-178/DO-331 > High-
Integrity Systems. The high-integrity subgroup in which the check resides is defined in the table.

High-Integrity Systems
Subgroup

Check Name

Simulink Check for root Inports with missing properties
Simulink Check for root Inports with missing range definitions
Stateflow Check Stateflow charts for transition paths that cross parallel

state boundaries
Stateflow Check Stateflow charts for strong data typing
Stateflow Check usage of shift operations for Stateflow data
Stateflow Check assignment operations in Stateflow Charts
Stateflow Check Stateflow charts for unary operators
Stateflow Check usage of Stateflow constructs
Configuration Check safety-related solver settings for simulation time
Configuration Check safety-related solver settings for solver options
Configuration Check safety-related solver settings for tasking and sample-time
Configuration Check safety-related diagnostic settings for Merge blocks
Configuration Check safety-related diagnostic settings for Stateflow
Configuration Check safety-related optimization settings for Loop unrolling

threshold
Code Check for blocks not recommended for MISRA C:2012
Code Check configuration parameters for MISRA C:2012

The following table identifies modifications to existing Model Advisor checks for DO-178C/DO-331
safety standards.
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https://www.mathworks.com/help/releases/R2017b/slcheck/ref/do-178c-checks.html#mw_8ac12d3f-6a5d-4316-8311-3b49fc9dab67
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/do-178c-checks.html#mw_cc853eab-3d58-46e1-98c5-3cceda5bd7f5
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https://www.mathworks.com/help/releases/R2017b/slcheck/ref/do-178c-checks.html#mw_547a01f1-40cc-4ae4-bede-2c18a3260292
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/do-178c-checks.html#mw_18fe65c3-efa3-409e-8a44-b26285d9294a
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/do-178c-checks.html#mw_9e002fe6-4edc-47a0-95c9-dd4a64ff0270
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/do-178c-checks.html#mw_6b22a208-1bf7-47a2-bb6d-59c504b6e8b9
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/do-178c-checks.html#mw_234640eb-7fc9-421c-b3f7-7c01fb2e9db1
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/do-178c-checks.html#mw_1ad38dcc-380c-471b-9e9d-b945368909ef
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/do-178c-checks.html#mw_b2b58eac-84c0-4710-ad9c-ba20f01155cc
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/do-178c-checks.html#mw_d7e66d97-24e3-4212-8257-346c594f0394
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/do-178c-checks.html#mw_4490e9f0-7526-47ba-be25-46425c13b1bd
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/do-178c-checks.html#mw_90e1a6f0-44ed-45b0-8deb-d70d4fe96ead
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/do-178c-checks.html#mw_90e1a6f0-44ed-45b0-8deb-d70d4fe96ead
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/do-178c-checks.html#brlhdcb.bsc06fh-1
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/do-178c-checks.html#brlhdcb.bsc06fj-1


Model Advisor Check Description of Change
Check for model elements that do not link to
requirements

Check title has been updated. In previous
releases, the title of this check was Check for
blocks that do not link to requirements. The
check ID did not change.

Check model for block upgrade issues No longer available as a Modeling Standards
for DO-178C/DO-331 check. For more
information, see “DO-178C/DO-331 Modeling
Checks: Removed Model Advisor check "Check
model for block upgrade issues"” on page 8-14.

High-Integrity Model Advisor Checks for EN 50128, IEC 61508, IEC 62304, and ISO 26262
Standards

The following table identifies the Model Advisor checks that have been introduced in R2017b to check
compliance with safety standards EN 50128, IEC 61508, IEC 62304, and ISO 26262.

These checks are available at:

• By Task > Modeling Standards for EN 50128 > High-Integrity Systems
• By Task > Modeling Standards for IEC 61508 > High-Integrity Systems
• By Task > Modeling Standards for IEC 62304 > High-Integrity Systems
• By Task > Modeling Standards for ISO 26262 > High-Integrity Systems

The high-integrity subgroup in which the check resides is defined in the table.

High-Integrity Systems
Subgroup

Check Name

Simulink Check usage of lookup table blocks
Simulink Check for blocks not recommended for C/C++ production code

deployment
Simulink Check for variant blocks with 'Generate preprocessor

conditionals' active
Simulink Check usage of Signal Routing blocks
Stateflow Check Stateflow charts for transition paths that cross parallel

state boundaries
Stateflow Check Stateflow charts for ordering of states and transitions
Stateflow Check Stateflow debugging options
Stateflow Check Stateflow charts for uniquely defined data objects
Stateflow Check Stateflow charts for strong data typing
Stateflow Check usage of shift operations for Stateflow data
Stateflow Check assignment operations in Stateflow Charts
Stateflow Check Stateflow charts for unary operators
Stateflow Check usage of Stateflow constructs
Configuration Check safety-related optimization settings
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https://www.mathworks.com/help/releases/R2017b/slcheck/ref/do-178c-checks.html#bryz4j2-1
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/do-178c-checks.html#bryz4j2-1
https://www.mathworks.com/help/releases/R2017b/simulink/slref/simulink-checks_bq6d4aa-1.html#bq89gfp
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_cab4fc67-8d2c-46b0-ae50-fe2e2b4704b3
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#btqhuh9-1
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#btqhuh9-1
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_db105cba-5130-4114-a6af-e54a18555f64
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_db105cba-5130-4114-a6af-e54a18555f64
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#bsvyx77-7
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_8e9fed5e-0ccc-42fc-a2c4-25aecd2e5b73
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_8e9fed5e-0ccc-42fc-a2c4-25aecd2e5b73
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_e32b86b8-3690-45f8-b89f-e5ca5159f4aa
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_c1327685-821a-4679-8788-3b4d5650d7c3
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_3881eeea-d34c-4970-b260-8b89673d04d7
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_7a8b900e-3eb8-4b24-97b4-80b5cc503712
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_6affc3d2-4cdf-419d-849a-0dcb522127e7
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_3f7e8a10-9dff-4a4c-a685-f7c7dc75b8b7
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_4543a17f-0abb-4f51-925e-65a9aa272f0e
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#brrkitw
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_d837443b-e8a1-4c10-a0d0-18b634b779b9


High-Integrity Systems
Subgroup

Check Name

Configuration Check safety-related model referencing settings
Configuration Check safety-related code generation settings
Configuration Check safety-related diagnostic settings for solvers
Configuration Check safety-related solver settings for simulation time
Configuration Check safety-related solver settings for solver options
Configuration Check safety-related solver settings for tasking and sample-time
Configuration Check safety-related diagnostic settings for sample time
Configuration Check safety-related diagnostic settings for signal data
Configuration Check safety-related diagnostic settings for parameters
Configuration Check safety-related diagnostic settings for data used for

debugging
Configuration Check safety-related diagnostic settings for data store memory
Configuration Check safety-related diagnostic settings for type conversions
Configuration Check safety-related diagnostic settings for signal connectivity
Configuration Check safety-related diagnostic settings for bus connectivity
Configuration Check safety-related diagnostic settings that apply to function-

call connectivity
Configuration Check safety-related diagnostic settings for compatibility
Configuration Check safety-related diagnostic settings for model initialization
Configuration Check safety-related diagnostic settings for model referencing
Configuration Check safety-related diagnostic settings for saving
Configuration Check safety-related diagnostic settings for Merge blocks
Configuration Check safety-related diagnostic settings for Stateflow
Configuration Check safety-related optimization settings for Loop unrolling

threshold
Requirements Check for model elements that do not link to requirements
Code Check configuration parameters for MISRA C:2012
Code Check for blocks not recommended for MISRA C:2012

High-Integrity Modeling Guidelines

High-integrity system modeling guideline hisl_0070: Placement of requirement links in a model was
introduced in R2017b.

These high-integrity system modeling guidelines were removed in R2017b:

• hisf_0010: Usage of transition paths (looping out of parent of source and destination objects)
• hisf_0012: Chart comments
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https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_6d2a9f3c-99db-4ed3-9f98-a64d2ca250c5
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https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_8e3b43b6-f478-45c9-8916-5deeceac1933
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_c39ab0dd-b4c9-4fac-ace7-f16810af8fae
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_c3f7d444-3f00-439d-b00b-a52b279712d7
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_20d8d49b-eb6d-444c-9f10-837dfd075939
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_dddd0fe2-515d-4e50-8930-201aa4ada5b7
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_dddd0fe2-515d-4e50-8930-201aa4ada5b7
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_ee7bba59-4494-4037-a8fc-df71cb011c2b
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_5d008399-a5c6-4d93-b9a3-f80dc703e7a6
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_96ca26db-70e2-4c6e-85f1-66d34d12d3dc
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_6176da21-0090-4fe2-b397-dc9d504b6407
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https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_5fefdab3-4dd1-43db-be1f-e1a6a74564dc
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_f50e0502-1e4b-4e65-868d-35030f9087a3
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_ef59ad35-544d-4ddc-8ae1-d3957121b75b
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_caad104c-ab83-428a-ac5c-cd7a6c95bf97
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_caad104c-ab83-428a-ac5c-cd7a6c95bf97
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#br547qz-1
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#brlhdal.bsc06fj-1
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#brlhdal.bsc06fh-1
https://www.mathworks.com/help/releases/R2017b/simulink/mdl_gd/hi/requirements.html#mw_cc3865f8-3f1c-4827-9cf5-eada5924e512


The high-integrity system modeling guidelines in this table were updated to include new Model
Advisor checks for DO-178C/DO-331, EN 50128, IEC 61508, IEC 62304, and ISO 26262 safety
standards. Where applicable, the table also identifies additional modifications.

For a complete list of high-integrity system modeling guidelines, including their applicable Model
Advisor checks, see Model Advisor Checks for High-Integrity Modeling Guidelines (Simulink).

High-Integrity Modeling Guideline Description of Change
hisl_0002: Usage of Math Function
blocks (rem and reciprocal)

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check usage of Math Operations
blocks

hisl_0004: Usage of Math Function
blocks (natural logarithm and base 10
logarithm)

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check usage of Math Operations
blocks

hisl_0005: Usage of Product blocks New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check safety-related diagnostic
settings for signal data

hisl_0013: Usage of data store blocks New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check safety-related diagnostic
settings for data store memory

hisl_0018: Usage of Logical Operator
block

Removed Model Advisor check Check safety-related
optimization settings as it is covered via the prerequisite
guideline.

hisl_0020: Blocks not recommended
for MISRA C:2012 compliance

New Model Advisor checks:

• DO-178C/DO-331: Check for blocks not recommended for
MISRA C:2012

• IEC 61508, IEC 62304, EN 50128, and ISO 26262: Check
for blocks not recommended for MISRA C:2012

• IEC 61508, IEC 62304, EN 50128, and ISO 26262: Check
for blocks not recommended for C/C++ production code
deployment

Added:

• Added From Workspace and S-Function Builder blocks to
the list of blocks not recommended for MISRA
compliance

• Identified the deprecated Lookup Table blocks (Lookup
and Lookup2D).

hisl_0022: Data type selection for
index signals

Removed n-D Lookup Table (internal type index selection)
from the list of blocks that use a signal index.

hisl_0023: Verification of model and
subsystem variants

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check for variant blocks with
'Generate preprocessor conditionals' active
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High-Integrity Modeling Guideline Description of Change
hisl_0024: Inport interface definition New Model Advisor check for DO-178C/DO-331: Check for

root Inports with missing properties

Updated guideline description to include Simulink signal
object that explicitly resolves to the connected signal line.

hisl_0025: Design min/max
specification of input interfaces

New Model Advisor check for DO-178C/DO-331: Check for
root Inports with missing range definitions

hisl_0026: Design min/max
specification of output interfaces

New Model Advisor check for DO-178C/DO-331: Check for
root Outports with missing range definitions

hisl_0033: Usage of Lookup Table
blocks

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check usage of lookup table blocks

hisl_0034: Usage of Signal Routing
blocks

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check usage of Signal Routing blocks

hisl_0036: Configuration Parameters
> Diagnostics > Saving

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check safety-related diagnostic
settings for saving

hisl_0037: Configuration Parameters
> Model Referencing

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check safety-related model
referencing settings

hisl_0038: Configuration Parameters
> Code Generation > Comments

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check safety-related code generation
settings

hisl_0039: Configuration Parameters
> Code Generation > Interface

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check safety-related code generation
settings

hisl_0040: Configuration Parameters
> Solver > Simulation time

New Model Advisor checks:

• DO-178C/DO-331: Check safety-related solver settings for
simulation time

• IEC 61508, IEC 62304, EN 50128, and ISO 26262: Check
safety-related solver settings for simulation time

hisl_0041: Configuration Parameters
> Solver > Solver options

New Model Advisor checks:

• DO-178C/DO-331: Check safety-related solver settings for
solver options

• IEC 61508, IEC 62304, EN 50128, and ISO 26262: Check
safety-related solver settings for solver options

hisl_0042: Configuration Parameters
> Solver > Tasking and sample time
options

New Model Advisor checks:

• DO-178C/DO-331: Check safety-related solver settings for
tasking and sample-time

• IEC 61508, IEC 62304, EN 50128, and ISO 26262: Check
safety-related solver settings for tasking and sample-time
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High-Integrity Modeling Guideline Description of Change
hisl_0043: Configuration Parameters
> Diagnostics > Solver

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check safety-related diagnostic
settings for solvers

hisl_0044: Configuration Parameters
> Diagnostics > Sample Time

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check safety-related diagnostic
settings for sample time

hisl_0045: Configuration Parameters
> Optimization > Implement logic
signals as Boolean data (vs. double)

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check safety-related optimization
settings

hisl_0046: Configuration Parameters
> Optimization > Block reduction

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check safety-related optimization
settings

hisl_0047: Configuration Parameters
> Code Generation > Code Style

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check safety-related code generation
settings

hisl_0048: Configuration Parameters
> Optimization > Application lifespan
(days)

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262:Check safety-related optimization
settings

hisl_0049: Configuration Parameters
> Code Generation > Symbols

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check safety-related code generation
settings

hisl_0051: Configuration Parameters
> Optimization > Signals and
Parameters > Loop unrolling
threshold

New Model Advisor checks:

• DO-178C/DO-331: Check safety-related optimization
settings for Loop unrolling threshold

• IEC 61508, IEC 62304, EN 50128, and ISO 26262: Check
safety-related optimization settings for Loop unrolling
threshold

hisl_0052: Configuration Parameters
> Optimization > Data initialization

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check safety-related optimization
settings

hisl_0053: Configuration Parameters
> Optimization > Remove code from
floating-point to integer conversions
that wraps out-of-range values

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check safety-related optimization
settings

hisl_0054: Configuration Parameters
> Optimization > Remove code that
protects against division arithmetic
exceptions

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check safety-related optimization
settings

hisl_0060: Configuration parameters
that improve MISRA C:2012
compliance

New Model Advisor checks:

• DO-178C/DO-331: Check configuration parameters for
MISRA C:2012

• IEC 61508, IEC 62304, EN 50128, and ISO 26262: Check
configuration parameters for MISRA C:2012

R2017b
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High-Integrity Modeling Guideline Description of Change
hisl_0061: Unique identifiers for
clarity

New Model Advisor checks:

• DO-178C/DO-331: Check usage of Stateflow constructs
• IEC 61508, IEC 62304, EN 50128, and ISO 26262: Check
Stateflow charts for uniquely defined data objects

hisl_0301: Configuration Parameters
> Diagnostics > Compatibility

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check safety-related diagnostic
settings for compatibility

hisl_0302: Configuration Parameters
> Diagnostics > Data Validity >
Parameters

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check safety-related diagnostic
settings for parameters

hisl_0303: Configuration Parameters
> Diagnostics > Merge block

New Model Advisor checks:

• DO-178C/DO-331: Check safety-related diagnostic
settings for Merge blocks

• IEC 61508, IEC 62304, EN 50128, and ISO 26262: Check
safety-related diagnostic settings for Merge blocks

hisl_0304: Configuration Parameters
> Diagnostics > Model initialization

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check safety-related diagnostic
settings for model initialization

hisl_0305: Configuration Parameters
> Diagnostics > Debugging

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check safety-related diagnostic
settings for data used for debugging

hisl_0306: Configuration Parameters
> Diagnostics > Connectivity >
Signals

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check safety-related diagnostic
settings for signal connectivity

hisl_0307: Configuration Parameters
> Diagnostics > Connectivity > Buses

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check safety-related diagnostic
settings for bus connectivity

hisl_0308: Configuration Parameters
> Diagnostics > Connectivity >
Function calls

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check safety-related diagnostic
settings that apply to function-call connectivity

hisl_0309: Configuration Parameters
> Diagnostics > Type Conversion

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check safety-related diagnostic
settings for type conversions

Added Type Conversion parameters:

• Unnecessary type conversion
• 32-bit integer to single precision float conversion

hisl_0310: Configuration Parameters
> Diagnostics > Model Referencing

New Model Advisor check for IEC 61508, IEC 62304, EN
50128, and ISO 26262: Check safety-related diagnostic
settings for model referencing

 

8-9

https://www.mathworks.com/help/releases/R2017b/simulink/mdl_gd/hi/modeling-style_bsfqj7u-1.html#bspjtbu-1
https://www.mathworks.com/help/releases/R2017b/simulink/mdl_gd/hi/modeling-style_bsfqj7u-1.html#bspjtbu-1
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/do-178c-checks.html#mw_6b22a208-1bf7-47a2-bb6d-59c504b6e8b9
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_3881eeea-d34c-4970-b260-8b89673d04d7
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_3881eeea-d34c-4970-b260-8b89673d04d7
https://www.mathworks.com/help/releases/R2017b/simulink/mdl_gd/hi/diagnostics.html#bs5xbrw-1
https://www.mathworks.com/help/releases/R2017b/simulink/mdl_gd/hi/diagnostics.html#bs5xbrw-1
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_d504299c-cdf1-4da5-992f-21777f32877c
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_d504299c-cdf1-4da5-992f-21777f32877c
https://www.mathworks.com/help/releases/R2017b/simulink/mdl_gd/hi/diagnostics.html#bs5yxvc-1
https://www.mathworks.com/help/releases/R2017b/simulink/mdl_gd/hi/diagnostics.html#bs5yxvc-1
https://www.mathworks.com/help/releases/R2017b/simulink/mdl_gd/hi/diagnostics.html#bs5yxvc-1
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_20d8d49b-eb6d-444c-9f10-837dfd075939
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_20d8d49b-eb6d-444c-9f10-837dfd075939
https://www.mathworks.com/help/releases/R2017b/simulink/mdl_gd/hi/diagnostics.html#bs5yxuv-1
https://www.mathworks.com/help/releases/R2017b/simulink/mdl_gd/hi/diagnostics.html#bs5yxuv-1
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/do-178c-checks.html#mw_d7e66d97-24e3-4212-8257-346c594f0394
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/do-178c-checks.html#mw_d7e66d97-24e3-4212-8257-346c594f0394
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_f50e0502-1e4b-4e65-868d-35030f9087a3
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_f50e0502-1e4b-4e65-868d-35030f9087a3
https://www.mathworks.com/help/releases/R2017b/simulink/mdl_gd/hi/diagnostics.html#bs5xgk4-1
https://www.mathworks.com/help/releases/R2017b/simulink/mdl_gd/hi/diagnostics.html#bs5xgk4-1
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_6393f8e7-ca05-4e19-97d8-7ebe56fb5d6c
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_6393f8e7-ca05-4e19-97d8-7ebe56fb5d6c
https://www.mathworks.com/help/releases/R2017b/simulink/mdl_gd/hi/diagnostics.html#bs5xgt6-1
https://www.mathworks.com/help/releases/R2017b/simulink/mdl_gd/hi/diagnostics.html#bs5xgt6-1
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_dddd0fe2-515d-4e50-8930-201aa4ada5b7
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_dddd0fe2-515d-4e50-8930-201aa4ada5b7
https://www.mathworks.com/help/releases/R2017b/simulink/mdl_gd/hi/diagnostics.html#bs5xhvb-1
https://www.mathworks.com/help/releases/R2017b/simulink/mdl_gd/hi/diagnostics.html#bs5xhvb-1
https://www.mathworks.com/help/releases/R2017b/simulink/mdl_gd/hi/diagnostics.html#bs5xhvb-1
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_96ca26db-70e2-4c6e-85f1-66d34d12d3dc
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_96ca26db-70e2-4c6e-85f1-66d34d12d3dc
https://www.mathworks.com/help/releases/R2017b/simulink/mdl_gd/hi/diagnostics.html#bs5xm4l-1
https://www.mathworks.com/help/releases/R2017b/simulink/mdl_gd/hi/diagnostics.html#bs5xm4l-1
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_6176da21-0090-4fe2-b397-dc9d504b6407
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_6176da21-0090-4fe2-b397-dc9d504b6407
https://www.mathworks.com/help/releases/R2017b/simulink/mdl_gd/hi/diagnostics.html#bs5xndb-1
https://www.mathworks.com/help/releases/R2017b/simulink/mdl_gd/hi/diagnostics.html#bs5xndb-1
https://www.mathworks.com/help/releases/R2017b/simulink/mdl_gd/hi/diagnostics.html#bs5xndb-1
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_1a5858df-2a9b-4dfd-91bf-915280e4d9df
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_1a5858df-2a9b-4dfd-91bf-915280e4d9df
https://www.mathworks.com/help/releases/R2017b/simulink/mdl_gd/hi/diagnostics.html#bs5xnkr-1
https://www.mathworks.com/help/releases/R2017b/simulink/mdl_gd/hi/diagnostics.html#bs5xnkr-1
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_5d008399-a5c6-4d93-b9a3-f80dc703e7a6
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_5d008399-a5c6-4d93-b9a3-f80dc703e7a6
https://www.mathworks.com/help/releases/R2017b/simulink/mdl_gd/hi/diagnostics.html#bs5xnrt-1
https://www.mathworks.com/help/releases/R2017b/simulink/mdl_gd/hi/diagnostics.html#bs5xnrt-1
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_d7d19a78-51d9-4262-a155-d8aebefd0caa
https://www.mathworks.com/help/releases/R2017b/slcheck/ref/iec-61508-and-iso-26262-checks.html#mw_d7d19a78-51d9-4262-a155-d8aebefd0caa


High-Integrity Modeling Guideline Description of Change
hisl_0311: Configuration Parameters
> Diagnostics > Stateflow

New Model Advisor checks:

• DO-178C/DO-331: Check safety-related diagnostic
settings for Stateflow

• IEC 61508, IEC 62304, EN 50128, and ISO 26262: Check
safety-related diagnostic settings for Stateflow

The rational from hisf_0010: Usage of transition paths
(looping out of parent of source and destination objects) was
incorporated into this guideline.

hisf_0002: User-specified state/
transition execution order

New Model Advisor checks:

• DO-178C/DO-331: Check usage of Stateflow constructs
• IEC 61508, IEC 62304, EN 50128, and ISO 26262: Check
Stateflow charts for ordering of states and transitions

• IEC 61508, IEC 62304, EN 50128, and ISO 26262: Check
usage of Stateflow constructs

hisf_0009: Strong data typing
(Simulink and Stateflow boundary)

New Model Advisor check for DO-178C/DO-331: Check
usage of Stateflow constructs

hisf_0011: Stateflow debugging
settings

New Model Advisor checks:

• DO-178C/DO-331: Check usage of Stateflow constructs
• IEC 61508, IEC 62304, EN 50128, and ISO 26262: Check
Stateflow debugging options

• IEC 61508, IEC 62304, EN 50128, and ISO 26262: Check
usage of Stateflow constructs

hisf_0013: Usage of transition paths
(crossing parallel state boundaries)

New Model Advisor checks:

• DO-178C/DO-331: Check Stateflow charts for transition
paths that cross parallel state boundaries

• IEC 61508, IEC 62304, EN 50128, and ISO 26262: Check
Stateflow charts for transition paths that cross parallel
state boundaries

hisf_0015: Strong data typing (casting
variables and parameters in
expressions)

New Model Advisor checks:

• DO-178C/DO-331: Check Stateflow charts for strong data
typing

• IEC 61508, IEC 62304, EN 50128, and ISO 26262: Check
Stateflow charts for strong data typing

hisf_0064: Shift operations for
Stateflow data to improve code
compliance

New Model Advisor checks:

• DO-178C/DO-331: Check usage of shift operations for
Stateflow data

• IEC 61508, IEC 62304, EN 50128, and ISO 26262: Check
usage of shift operations for Stateflow data

Title update. No change to guideline content.

R2017b
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High-Integrity Modeling Guideline Description of Change
hisf_0065: Type cast operations in
Stateflow to improve code compliance

New Model Advisor checks:

• DO-178C/DO-331: Check assignment operations in
Stateflow charts

• IEC 61508, IEC 62304, EN 50128, and ISO 26262: Check
assignment operations in Stateflow charts

Title update. No change to guideline content.
hisf_0211: Protect against use of
unary operators in Stateflow Charts to
improve code compliance

New Model Advisor checks:

• DO-178C/DO-331: Check Stateflow charts for unary
operators

• IEC 61508, IEC 62304, EN 50128, and ISO 26262: Check
Stateflow charts for unary operators

Title update. No change to guideline content.

Modeling Support for Secure Coding Standards: Check model for
compliance with secure coding requirements in CERT C, CWE, ISO/IEC
TS 17961 standards to improve security of generated code
You can use Model Advisor to check the model or subsystem for compliance with secure coding
requirements in CERT C, CWE, and ISO/IEC TS 17961 standards. To execute these checks, Select and
Run Model Advisor Checks (Simulink) and select By Task > Modeling Guidelines for Secure
Coding (CERT C, CWE, ISO/IEC TS 17961).

This table summarizes the Modeling Standards for Secure Coding checks.

Check Description Addresses Secure
Coding Standards

Check configuration parameters
for secure coding standards

Identifies configuration parameters that
might impact code security.

 

Check for blocks not
recommended for C/C++
production code deployment

Identifies blocks not supported by code
generation or not recommended for C/C
++ production code deployment.

 

Check for blocks not
recommended for secure coding
standards

Identifies blocks not supported by
secure coding standards.

 

Check usage of Assignment
blocks

Identifies Assignment blocks that do not
have block parameter Action if any
output element is not assigned set to
Error or Warning

• ISO/IEC TS 17961:
2013, uninitref

• CERT C, EXP33-C
• CWE, CWE-908

Check for switch case
expressions without a default
case

Identifies switch case expressions that
do not have a default case.

• ISO/IEC TS 17961:
2013, swtchdflt

• CERT C, MSC01-C
• CWE, CWE-478
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Check Description Addresses Secure
Coding Standards

Check for bitwise operations on
signed integers

Identifies Simulink blocks that contain
bitwise operations on signed integers.
The check does not flag MATLAB
Function or Stateflow blocks that use
signed operands for bitwise operators.

• CERT C, INT13-C
• CWE, CWE-682

Check for equality and inequality
operations on floating-point
values

Identifies equality and inequality
operations on floating-point values.

• CERT C, FLP00-C
• CWE, CWE-697

Check integer word length Identifies integer word lengths that do
not comply with hardware
implementation settings.

• CERT C, INT13-C
• CWE, CWE-682

If you have Simulink Design Verifier, the following design error detection checks are also available as
part of the Modeling Standards for Secure Coding checks.

Check Description Addresses Secure
Coding Standards

Detect Dead Logic Identifies logic that stays inactive during
simulation.

• CERT C, MSC07-C
• CWE, CWE-561

Detect Integer Overflow Identifies operations that exceed the
data type range for integer or fixed-
point operations.

• ISO/IEC TS 17961:
2013, intoflow

• CERT C, INT30-C and
INT32-C

• CWE, CWE-190
Detect Division by Zero Identifies operations in the model that

cause division-by-zero errors.
• ISO/IEC TS 17961:

2013, diverr
• CERT C, INT33-C and

FLP03-C
• CWE, CWE-369

Detect Out Of Bound Array
Access

Detects operations that access outside
the bounds of an array index

• ISO/IEC TS 17961:
2013, invptr

• CERT C, ARR30-C
• CWE, CWE-118

Detect Violation of Specified
Minimum and Maximum Values

Checks the specified minimum and
maximum values (the design ranges) on
intermediate signals throughout the
model and on the output ports. If the
analysis detects that a signal exceeds
the design range, the results identify
where in the model the errors occurred.

• CERT C, API00-C
• CWE, CWE-628

For information about the secure coding standards organizations, see Secure Coding Standards
(Embedded Coder).
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MISRA C: 2012 Modeling Checks: Improve compliance of generated
code by using new MISRA C:2012 standards checks
To improve MISRA C:2012 compliance, these new checks are available through the Model Advisor. To
execute these checks, Select and Run Model Advisor Checks (Simulink) and select By Task >
Modeling Guidelines for MISRA C:2012.

Check Description Addresses
MISRA C:2012

Check for missing error ports for
AUTOSAR receiver interfaces

Identifies AUTOSAR receiver interface
inports that do not have matching error
ports.

Directive 4.7

Check for missing const qualifiers in
model functions

Identifies input data pointers that do not
have a const qualifier.

Rule 8.13

Check integer word length Identifies integer word lengths that do not
comply with hardware implementation
settings.

Rule 10.1

Modifications to existing MISRA C:2012 compliance checks are outlined in this table.

Check Description of Modification to the Check
Check for blocks not recommended for
MISRA C:2012

Flags the inclusion of From Workspaceblocks

Check configuration parameters for MISRA
C:2012

Flags the following parameter settings:

• Configuration parameter Wrap on overflow is set
to none.

• Configuration parameter Inf or NaN block output
is set to none

• Configuration parameter Dynamic memory
allocation in MATLAB Function blocks is
selected.

• Parameter ERTFilePackagingFormat is set to
Modular.

• Parameter PreserveStaticInFcnDecls is set to
off.

hisl_0060: Configuration parameters that improve
MISRA C:2012 compliance reflects these parameter
settings.

Check for switch case expressions without a
default case

Check can be executed on library models.

Check can exclude blocks when you have Simulink
Check.

Check for bitwise operations on signed
integers

Check can exclude blocks when you have Simulink
Check.
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Check Description of Modification to the Check
Check for equality and inequality operations
on floating-point values

Check can exclude blocks when you have Simulink
Check.

For information about MISRA C versions and updates, see MISRA C Guidelines (Embedded Coder).

DO-178C/DO-331 Modeling Checks: Removed Model Advisor check
"Check model for block upgrade issues"
In R2017b, Model Advisor check Check model for block upgrade issues (check ID
mathworks.design.Update) is no longer available under Analysis > Model Advisor > Modeling
Standards for DO-178C/DO-331 > Simulink.

You can still execute this check through the Upgrade Advisor (Simulink) at Analysis > Model
Advisor > Upgrade Advisor.

Model Metrics: Evaluate model quality by using new metric algorithms
Evaluate model quality by using these new model metrics:

• Simulink diagnostic warning count: Measures the number of Simulink diagnostic warnings
reported during model compilation for simulation.

• Parameter count: Measures the number of parameters in a model.
• Simulink clone count: Measures the number of clones in a model.
• Clone component content: Quantifies cloned content in the model.
• Library linked component content: Quantifies library-linked content in the model.
• Stateflow chart count: Measures the number of Stateflow charts at the model level.
• MatlabFunction count: Measures the number of MATLAB Function blocks at the model level.
• Explicit IO count: Measures the number of inports and outports to and from the model.
• File Count: Measures the number of model and library files.
• Model file count: Measures the number of model files.

For more information on these, and other available metric algorithms, see Model Metrics.

Model Metric APIs: Create custom metrics with more detailed results
and determine passed or failed compliance checks
In R2017b, the slmetric.metric.Result class contains the new property Details. Details is
an array of objects of the new class slmetric.metric.ResultDetail. You can write custom
metrics that use this new class to store details about what the Value property of the
slmetric.metric.Result object counts. You can also use this class to determine which MAAB and
DO-178C/DO-331 metrics passed or failed.

For existing classes, there are these new properties:
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Class New Property
slmetric.metric.ResultDetail Details
slmetric.metric.Result ID
slmetric.metric.ResultCollection Outdated
slmetric.metric.Metric SupportsResultDetails

For more information see, slmetric.metric.ResultDetail.

Compatibility Considerations
In R2017b, you cannot collect metric data for MISRA C:2012 and ISO 26262 metrics. Specifically,
these metrics are not available:

• mathworks.metrics.ModelAdvisorCheckCompliance.misra_c
• mathworks.metrics.ModelAdvisorCheckCompliance.ISO26262
• mathworks.metrics.ModelAdvisorCheckIssues.misra_c
• mathworks.metrics.ModelAdvisorCheckIssues.ISO26262

For the DO-178C/DO-331 compliance metrics, the metric IDs
mathworks.metrics.ModelAdvisorCheckCompliance.do178 and
mathworks.metrics.ModelAdvisorCheckIssues.do178 are now named
mathworks.metrics.ModelAdvisorCheckCompliance.hisl_do178 and
mathworks.metrics.ModelAdvisorCheckIssues.hisl_do178.

Model Advisor Configuration Editor: Select edit-time checks from
folders
In the Model Advisor Configuration Editor, the tool now lists edit-time checks in folders instead of in a
flat list. The folder structure is the same folder structure as for the Model Advisor. The Model Advisor
Configuration Editor includes only folders that contain edit-time checks.

For more information, see Organize Checks and Folders Using the Model Advisor Configuration
Editor .
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